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NHẬP MÔN THƯƠNG MẠI ĐIỆN TỬ 

 

ĐỀ CƯƠNG THỰC HÀNH 

 

Thời gian: 30 tiết – 10 tuần 

 

 

Tuần 1. Tìm hiểu một số khái niệm cơ bản và cài đặt wordpress (xem lại cài đặt 

wordpress) 

Cài đặt và cấu hình wordpress 

Làm quen với wordpress 

 

Tuần 1. Quản trị nội dung trên wordpress 

Post một bài viết mới 

Tùy chọn post nâng cao 

Thêm một trang mới 

Làm việc với các media file 

Quản lý post và page 

Quản lý media file 

Quản lý danh mục post và tag 

Tuần 2. Theme 

Theme là gì 

Theme miễn phí và có phí 

Cài đặt theme từ wordpress.org 

Tạo menu 

Tuần 3. Tùy chỉnh giao diện website 

Custom Header content 

Custom look of post 

Custom design and layout 

Tuần 4. Quản lý dữ liệu 

Lược đồ Cơ sở dữ liệu 

Chi tiết các bảng 

Các bảng CSDL wordpress 

 Thao tác trực tiếp trên CSDL  

Tuần 5.  
Tên miền, hosting 

Liên kết các site khác 

Quản lý comment 

Kết nối nội dung trên những site khác 

Giúp những website khác kết nội đến  

Tuần 6. SEO 

Tối ưu nội dung 

Tối ưu website 

Một số kỹ thuật SEO  

Tuần 7. Plugin 

Cài đặt các plugin từ wordpress.org 

Cài đặt các plugin từ những nguồn khác 

Tạo một file plugin 

Tạo Header 

Xác định đường dẫn 
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Các hàm active/deactive 

Các phương thức Uninstall 

Code 

Tuần 8.  
Quản lý cache 

Giải quyết spam 

Bảo mật cho website 

Tuần 9. Kiểm tra THCK 

 

 

 

Tuần 1. Tìm hiểu một số khái niệm cơ bản và cài đặt wordpress (xem lại cài đặt 

wordpress) 

• Cài đặt và cấu hình wordpress 

• Làm quen với wordpress 

 

Một số khái niệm:  

 

• Phần mềm CMS (Content Managerment System) là gì? 

• Webserver: Apache 

• Localhost 

• Sử dụng phần mềm XAMP 

 

Tải phần mềm Vertrigo, XAMP, WAMP - tích hợp  

• Apache 2.4.18 

• PHP 5.5.30 

• MySQL 5.6.28 

• SQLite 3.9.2 

• PhpMyAdmin 4.5.2 

Localhost là gì? 

Vậy localhost nghĩa là một máy chủ được vận hành trên máy tính của . 

• Phần mềm Webserver tên Apache, đây là webserver thông dụng nhất. 

• Phần mềm PHP để xử lý mã PHP vì WordPress viết bằng ngôn ngữ PHP. 

• Phần mềm MySQL Server để lưu trữ và xử lý cơ sở dữ liệu, do WordPress sử 

dụng MySQL làm nền tảng cơ sở dữ liệu. Cơ sở dữ liệu thường được mình viết theo 

chữ tiếng Anh là database. 

• Phần mềm PHPMyAdmin để xem và quản lý cơ sở dữ liệu MySQL. 

IP của localhost - 127.0.0.1 – Muốn truy xuất dưới dạng giao thức HTTP cần cài một phần 

mềm Webserver. Để chạy localhost với đường dẫn là http://localhost. 
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Lưu ý trước khi cài đặt 

Xoá toàn bộ ứng dụng liên quan tới localhost 

Nếu  có cài đặt các phần mềm liên quan đến việc làm localhost như PHP, MySQL thì hãy xoá 

hết. Và  không nên cài XAMPP trên Windows Server đã cài đặt IIS. 

Tắt tường lửa 

Nếu máy  có cài đặt tường lửa từ Windows hay từ một phần mềm Antivirus nào khác thì hãy tắt 

nó đi vì có thể nó sẽ chặn cổng 80 hoặc các ứng dụng webserver. 

Tắt UAC trên Windows 

Nếu máy của  đang dùng Windows và có bật chức năng User Account Control thì hãy tắt nó đi 

khi dùng localhost để tránh các vấn đề bị giới hạn quyền. 

Hướng dẫn cài đặt WAMP 

Để tải XAMPP, đầu tiên  truy cập vào địa chỉ https://www.apachefriends.org/download.html và 

chọn phiên bản XAMPP phù hợp với hệ điều hành của máy tính  đang sử dụng, và  nên chọn 

phiên bản PHP 5.4.31. Lưu ý là XAMPP chỉ có phiên bản cho hệ điều hành 32bit nhưng 64bit 

vẫn hoạt động bình thường. 

.

 

Sau khi tải file cài đặt về xong, hãy chạy nó, sau đó chọn Next. 

https://www.apachefriends.org/download.html
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Ở phần chọn đường dẫn,  hãy chọn đường dẫn cần lưu cài đặt của XAMPP. Lưu ý rằng đường 

dẫn này  phải nhớ vì khi cài đặt web lên localhost,  phải truy cập vào thư mục này.  nên để mặc 

định là c:\xampp. Tiếp tục ấn Next. 

 

Ở trang kế tiếp,  bỏ chọn phần “Learn more about Bitnami for XAMPP“. Và ấn Next 2 lần nữa 

để bắt đầu quá trình cài đặt XAMPP. 
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Sau khi cài xong, ấn nút Finish để kết thúc cài đặt và mở bảng điều khiển của XAMPP. Tuy 

nhiên, hãy khởi động lại máy sau khi cài đặt xong để tránh tình trạng không khởi động được 

localhost. 

Khởi động Localhost 

Bây giờ  hãy vào thư mục c:\xampp và mở file xampp-panel.exe lên để bật bảng điều khiển 

của XAMPP. 



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 6 | @TaiLieuITIUH 
 

Bảng điều khiển của XAMPP 

 

 để ý sẽ thấy hai ứng dụng Apache và MySQL có nút Start, đó là dấu hiệu bảo 2 ứng dụng này 

chưa được khởi động, hãy ấn vào nút Start của từng ứng dụng để khởi động Webserver Apache 

và MySQL Server lên thì mới chạy được localhost. 

Nếu cả hai ứng dụng chuyển sang màu xanh như hình dưới là đã khởi động thành công. 

 

Sau khi khởi động xong,  hãy truy cập vào website với địa chỉ là http://localhost sẽ thấy nó 

hiển thị ra trang giới thiệu XAMPP như hình dưới. 
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 có thể ấn vào nút English phía bên dưới để truy cập vào trang quản lý localhost. 

 

 Thao tác trên localhost 

Bây giờ  hãy vào thư mục C:\xampp\htdocs\ và tạo một thư mục tên “TMDT“, thư 

mục này sẽ chứa website của mình.  có thể sử dụng đường dẫn http://localhost/TMDT để chạy. 

Vậy bây giờ mình có thể nói, thư mụcC:\xampp\htdocs\TMDTchính là thư mục gốc của tên 

miền http://localhost/TMDT 

Bây giờ  thử copy một tập tin nào đó vào trong thư mục C:\xampp\htdocs\TMDT rồi chạy tên 

miềnhttp://localhost/TMDT,  sẽ thấy nó liệt kê file mà  vừa copy vào. 

Nếu  click vào file ảnh đó thì trình duyệt sẽ hiển thị ảnh với đường dẫn 

là http://localhost/TMDT/tên-tập-tin. Đây được xem là một link ảnh trong website của . 

Tương tự, hãy thử tạo một thư mục bất kỳ rồi copy một tập tin nào đó vào, thì bây giờ  có thể 

truy cập xem ảnh với đường dẫn là http://localhost/TMDT/tên-folder/tên-tập-tin. 
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Như vậy  có thể hiểu, cái đường dẫn trên website nó sẽ phân thứ cấp tùy theo cấu trúc 

thư mục và file trong đó. 

Cách đổi cổng mạng cho Localhost 

Mặc định Localhost sẽ sử dụng cổng 80, bởi vì khi  gõ tên miền như http://localhost thì tức là 

nó đã sử dụng cổng 80 để đọc các dữ liệu web trong localhost. Tuy nhiên nếu như  đã dùng 

cổng 80 cho một ứng dụng khác, hoặc đơn giản là không khởi động Apache được thì  nên thiết 

lập cho Apache trong Localhost sử dụng một cổng khác, như 8080 chẳng hạn. 

Trước khi đổi, mình cần các  lưu ý là sau khi đổi xong thì  phải truy cập vào website với 

tên miền http://localhost:8080 thay vì chỉ là http://localhost. 

Để đổi cổng,  mở bảng điều khiển XAMPP lên và chọn nút Config của Apache, sau đó 

chọn Apache (httpd.conf). 

 

Sau đó  tìm dòng này: 

Listen 80 

Đổi thành 

Listen 8080 

Sau đó  Stop cái Apache và Start lại rồi thử truy cập vào localhost theo đường 

dẫn http://localhost:8080, nếu truy cập được thì  đã làm thành công. Và cũng nên lưu ý rằng, 

sau khi đổi cổng thì mỗi khi truy cập  phải sử dụng đường dẫn có kèm theo số cổng  vừa đổi 

sang vì mặc định nếu không điền thì nó sẽ sử dụng cổng 80. 
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Nếu  có sử dụng tên miền ảo như mình hướng dẫn ở trên thì  cũng nên sửa lại 

file C:\xampp\apache\conf\extra\httpd-vhost.conf cho nó sử dụng port 80 thay vì 8080. 

 

 

HƯỚNG DẪN CÀI ĐẶT WORDPRESS 

WordPress là gì? 

WordPress là một phần mềm nguồn mở (Open Source Software) được viết bằng ngôn ngữ lập 

trình website PHP (Hypertext Preprocessor) và sử dụng hệ quản trị cơ sở dữ liệu MySQL. 

WordPress được ra mắt lần đầu tiên vào ngày 27/5/2003 bởi tác giả Matt Mullenweg và Mike 

Little.  

Hiện nay,  WordPress đã được xem như là một hệ quản trị nội dung (CMS – Content 

Management System) vượt trội để hỗ trợ người dùng tạo ra nhiều thể loại website khác nhau 

như blog, website tin tức/tạp chí, giới thiệu doanh nghiệp, bán hàng – thương mại điện 

tử, thậm chí với các loại website có độ phức tạp cao như đặt phòng khách sạn, thuê xe, đăng dự 

án bất động sản,… 

 

Một số kết quả ứng dụng của WordPress 

Khi tìm hiểu về WordPress,  sẽ thật tự hào khi biết rằng mã nguồn mà các  đang tìm hiểu ngay 

sau đây có những thành tựu rất vượt bậc và là một mã nguồn CMS mở phổ biến nhất hành tinh. 

Để kiểm chứng điều đó, các  cần biết là: 

• Trên thế giới, có khoảng 25 bài viết được đăng lên các website sử dụng WordPress mỗi 

giây. 

• Số lượng website làm bằng WordPress chiếm 23% tổng số lượng website trên thế giới. 

• Trong số 100% các website sử dụng mã nguồn CMS, WordPress chiếm 60%. 

• Phiên bản WordPress 4.0 đạt hơn 16 triệu lượt tải chỉ sau khoảng hai tháng. 

• WordPress đã được dịch sang 52 ngôn ngữ khác nhau. Tuy nhiên lại chưa có phiên bản 

tiếng Việt chính thức, nhưng  có thể Việt hóa dễ dàng bằng cách tìm bài trên blog với từ 

khóa “Việt hóa WordPress“. 

• Có hơn 80 chương trình họp mặt về WordPress được tổ chức vào năm 2014. 

• Mã nguồn WordPress hiện đang có khoảng 785 lập trình viên cùng hợp tác phát triển. 

• Chỉ tính các giao diện (hay còn gọi là theme) miễn phí trên thư viện WordPress.org thì 

đã có hơn 2.700 themes khác nhau. 

Ưu điểm:  

• Dễ sử dụng 

• Cộng đồng hỗ trợ đông đảo 

http://thachpham.com/nen-dung/vhost
http://en.wikipedia.org/wiki/Matt_Mullenweg
http://en.wikipedia.org/wiki/Mike_Little
http://en.wikipedia.org/wiki/Mike_Little
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• Nhiều gói giao diện (theme) có sẵn (có phí, miễn phí) 

• Nhiều plugin (trình cài đặt/ cắm thêm) hỗ trợ để bổ sung các chức năng mà  cần.  

• Dễ phát triển cho lập trình viên: cần thành thạo HTML, CSS, PHP với nguồn thư viện 

khổng lồ - Với hàng nghìn hàm (function) có sẵn. Hầu như quy trình làm việc của một 

lập trình viên chuyên nghiệp có thể ứng dụng dễ dàng vào WordPress. 

• Hỗ trợ nhiều ngôn ngữ 

• Có thể làm nhiều loại website: blog cá nhân, web bán hàng, một website giới thiệu công 

ty, một tờ tạp chí online bằng việc sử dụng kết hợp các theme và plugin với nhau.  

Những lưu ý cách hiểu chưa đúng về WordPress 

WordPress chỉ là một phần mềm nguồn mở được viết bằng PHP & MySQL để giúp  tạo 

được website nhanh hơn. Nhưng đó không có nghĩa là nó sẽ giúp  tạo được một website bất kỳ 

chỉ với các thao tác đơn giản. 

WordPress chỉ dành cho người không biết code: là không chính xác. Vì ngoài các tính 

năng có sẵn, thư viện giao diện phong phú và các plugin hỗ trợ cũng đã đủ để làm được 

website.  

 

 

 

 

Sau khi cài đặt xong một localhost hoàn chỉnh rồi, bây giờ chúng ta có thể tiến 

hành cài đặt WordPress vào localhost để khởi tạo một website trên mạng host ảo của mình 

nhé. 

Trước khi cài đặt, các  nên tạo một thư mục riêng tại thư mục “C:\\xampp\htdocs” để dễ dàng 

quản lý, 

Các bước cài đặt WordPress trên localhost 

1. Bước 1. Tải mã nguồn từ website WordPress.org 

2. Bước 2. Copy mã nguồn WordPress vào Localhost 

3. Bước 3. Tạo mới một database 

4. Bước 4. Chạy website để cài đặt 
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Bước 1. Tải mã nguồn từ website WordPress.org  Tải phần mềm WordPress (bản tiếng Việt) 

- https://vi.wordpress.org/wordpress-4.3.2-vi.zip 

Sau đó,  giải nén ra sẽ có được một thư mục mang tên “wordpress“. Có thể thư mục 

wordpress này sẽ được lồng trong một thư mục khác tên là wordpress-x (x ở đây là số phiên 

bản), nhưng nói chung  cứ vào sẽ có được một thư mục tên wordpress như hình dưới. 

Thư mục sau 

khi giải nén mã nguồn 

Tiếp tục, hãy truy cập vào thư mục wordpress,  sẽ thấy có một số thư mục tên là wp-admin, wp-

includes, wp-content và một số tập tin tên là index.php, wp-config-sample.php,…Tất cả tập 

tin và thư mục này, chúng ta gọi nó là mã nguồn WordPress. 

 

 
 

Các tập tin và thư mục mã nguồn của WordPress. 

Bước 2. Copy mã nguồn WordPress vào Localhost 

Bây giờ, hãy copy toàn bộ file và thư mục này vào thư mục website của  trong localhost (ví 

dụ:C:\xampp\htdocs\TMDT). Nghĩa là  chỉ copy các file và thư mục mã nguồn thôi, không 

https://vi.wordpress.org/wordpress-4.3.2-vi.zip
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copy cả thư mục wordpress vì chúng ta cần cài WordPress vào tên miền 

http://localhost/TMDT mà, nếu  copy cả thư mục wordpress vào thì website của  sẽ có đường 

dẫn là http://localhost/TMDT/wordpress/. 

Bước 3. Tạo mới một database (CSDL MySQL) 

Để chạy được WordPress thì localhost của  phải có một database dùng MySQL để nó có 

thể lưu các dữ liệu mềm vào đó như bài viết, các thiết lập,…trên website. 

Thao tác này  sẽ phải làm trong bước cài đặt WordPress trên localhost nhưng ở đây 

mình sẽ hướng dẫn trước để  có thể làm thử luôn. 

Khi nhắc đến database,  phải nhớ là nó bao gồm 3 thành phần chính là: 

• Tên user của database. 

• Mật khẩu của user database. 

• Tên database. 

• Database Host (thường thì điền là localhost, bất kể là  dùng ở localhost hay host bình 

thường). 

 hãy tưởng tượng rằng, user của database sẽ có nhiệm vụ đọc và ghi dữ liệu vào database 

nên khi sử dụng các mã nguồn PHP,  phải khai báo cùng lúc cả user của database và tên 

database. 

Đối với localhost,  không cần tạo user cho database mà sẽ sử dụng thông tin user như sau: 

• Tên user database: root 

• Mật khẩu: bỏ trống 

Do vậy, chúng ta chỉ cần tạo database là đủ. 

Để tạo database,  hãy truy cập vào localhost với đường dẫn http://localhost/phpmyadmin. Sau 

đó  nhấp vào menu Databases. 
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Sau đó ở phần Create databsae,  nhập tên database cần tạo vào ô Database name, phần 

Collation  hãy chọn là utf8_unicode_ci như hình dưới rồi ấn nút Create. 

Tạo xong hãy nhìn bên menu tay trái, nếu nó xuất hiện tên database vừa tạo là thành công. Vậy 

bây giờ, chúng ta tạm có một databse với các thông tin như: 

• Database Host: localhost 

• Database user: root 

• Database password: trống 

• Database name: TMDT 

Bước 4. Chạy website để cài đặt 

Sau khi copy xong, hãy mở bảng điều khiển của XAMPP lên và khởi động Apache và MySQL. 

Sau đó truy cập vào website với đường dẫn http://localhost/TMDT 
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Ở bước tiếp theo, nó sẽ nhắc nhở cho  là chưa tiến hành đổi file wp-config-sample.php thành 

wp-config.php và khai báo thông tin database vào đó. Hãy ấn  Let’s Go để nó tự làm việc đó 

cho . 

Và bây giờ là nhập thông tin database.. 

 

Hãy luôn nhớ rằng trên localhost, User Name của database luôn là root, mật khẩu để trống 

(vẫn có cách thiết lập nhưng không cần thiết) và Database Host luôn là localhost. 

Table Prefix nghĩa là tiền tố của database chứa dữ liệu WordPress, mặc định nó sẽ là wp_, 

chúng ta có thể đổi nó thành bất cứ cái gì nhưng phải bắt buộc có _ đằng sau. 

Khi nhập xong thông tin database, hãy ấn nút Submit để làm bước kế tiếp. Nếu bước kế tiếp nó 

hiện ra như hình dưới thì nghĩa là  đã nhập thông tin database chính xác, hãy ấn nút Run the 

install để bắt đầu cài đặt. 

 

User: admin 
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Pass: QyGCkx&TwzsDo6q9Fp 

 

Ở bước cài đặt này, các  sẽ cần phải thiết lập các thông tin quan trọng cho website như Tên của 

website, tên tài khoản admin cùng mật khẩu,…Nhập xong hãy ấn nút Install WordPress. 

 

Và nếu nó hiện chữ Success! như thế này là  đã cài đặt thành công, click vào nút Log in để 

đăng nhập vào bảng quản trị WordPress. 

Và đây là giao diện trang quản trị của WordPress. 

 
Trang quản trị của WordPress sau khi cài đặt 

Và ở đây, mình cần các  hiểu rằng, nếu truy cập vào tên miền chính 

như http://localhost/TMDT, nó sẽ ra trang chủ của website WordPress như thế này. 
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Trang chủ website sau khi cài WordPress 

Còn nếu muốn truy cập vào trang quản trị Admin của WordPress thì sẽ thêm /wp-admin vào 

đường dẫn thànhhttp://localhost/TMDT/wp-admin. 
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Tuần 2: Tìm hiểu một số tính năng của WP - Quản trị web site 

 

Giao diện mặc định 

Quản lý các trang 

Quản trị danh mục, bài viết 

Quản lý menu 

 

 

Quản lý bài viết 

1. Quản lý chuyên mục 

Có rất nhiều bài viết thuộc các chuyên mục khác nhau, vì vậy ta cần quản lý các chuyên 

mục để dễ dàng phân loại bài viết. 

Để quản lý chuyên mục, vui lòng truy cập Bài viết -> Chuyên mục ở menu quản lý bên 

trái. 

 

 

Thêm mới chuyên mục, vui lòng nhập các thông tin: 

- Tên/Name: ví dụ: “Tin Tức” 

- Chọn Cha Mẹ /Parent (nếu có) 

- Upload hình đại diện  

- Chọn kiểu hiển thị (mặc định là tin tức) 

Sau đó nhấn Thêm chuyên mục  

 

 
Sửa/xóa các chuyên mục, rê chuột vào tên chuyên mục cần 

sửa/xóa, các tác vụ sẽ hiển thị để các  chọn.  

2. Quản lý bài viết 

Để quản lý bài viết, vui lòng truy cập Bài viết -> Tất cả bài 

viết ở menu quản trị bên trái 

• Chỉnh sửa: Rê chuột đến bài viết để chọn chỉnh sửa hoặc 

xóa bài viết. 

• Các  có thể chọn nhiều bài xóa cùng lúc bằng cách tick vào 

các ô trống, chọn tác vụ,  sau đó chọn Áp dụng. 

• Thêm bài viết mới, click chọn  Viết bài mới 
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Các thông tin cần nhập khi Thêm mới hoặc Chỉnh sửa bài viết. 

Nhập thông tin  

o Tiêu Đề (Title) 

o Nội dung cho bài viết.  

o Chọn chuyên mục cho bài viết. Có thể thêm 1 chuyên mục ngay phía dưới. 

o Ảnh tiêu biểu: 

o Thêm tag: dùng phân loại post, rộng hơn.  

 

***Thêm media: thêm hình vào bài viết, chọn hình có sẵn trong thư viện, hoặc upload 

hình mới từ máy tính. 

 
 

 

 
Tải (các)hình lên rồi chọn (các) hình ảnh . Sau đó click chọn Chèn vào bài viết 

 

Quản lý các trang 

 

Page rất thích hợp cho  sử dụng để đăng các nội dung có tính chất chung chung mà không cần 

phải phân loại như: 

- Trang liên hệ. 

- Trang giới thiệu. 



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 19 | @TaiLieuITIUH 
 

- Trang giới thiệu dịch vụ. 

Sau khi,  đăng nhập thực hiện chọn Trang -> Tất cả các trang ở Menu quản trị bên trái. 

 
 

Giao diện quản lý các trang 

 

Để thực hiện các thao tác với các trang hiện có (Chỉnh sửa, xóa), vui lòng rê chuột vào tên 

của trang, website sẽ hiện ra tác vụ để các  chọn. 

Để thực hiện thao tác với nhiều trang một lần, vui lòng đánh dấu vào ô trống ở đầu mỗi dòng 

của trang. Sau đó, chọn tác vụ muốn thực hiện trong ô chọn Tác vụ ở đầu hoặc cuối khung 

chứa các trang, sau đó nhấn Lọc. 

Thêm trang mới: 

Để thêm một trang mới, click vào nút Add new (Thêm mới) ở phía trên cùng trong trang 

quản lý Trang, hoặc click vào Trang -> Add new (Thêm mới) ở menu quản trị bên trái. 

 
 

- Thêm và chỉnh sửa Trang. 

Khi chọn Add new (Thêm mới) hoặc Chỉnh sửa một trang, các  sẽ được đưa đến trang soạn 

thảo.Tại trang soạn thảo, vui lòng nhập các nội dung: 

✓ Tên Trang (title) 

✓ Nội dung Trang  

✓ Chọn chuyên mục (cha mẹ) cho trang. Có thể thêm 1 chuyên mục ngay phía dưới. 

✓ Ảnh tiêu biểu : ảnh kích thước chuẩn chiều rộng >=1000px 
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- Cuối cùng, chọn Thêm Mới hoặc Cập Nhật để lưu kết quả 

Giao diện mặc định 

 

1 ./ Giao diện mặc định 

 

Sau khi, cài xong mã nguồn WordPress,  sẽ sử dụng một theme mặc định của WordPress. Tại 

trang chủ website sẽ thấy giao diện mặc định của WordPress là như thế này: 

 

 
 

Trong đó: 

 

- Site Name & Description: Site Name nghĩa là tên website của  mà  đã khai báo ở bước 

cài đặt, và Description là mô tả cho website của  – như là một slogan. 

Site Name 

- 

Description 

Slide bar 

Footer 

Thông tin 

bài post 

Nội dung 

bài post 
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- Sidebar: Nghĩa là một thanh nội dung nằm bên cạnh của nội dung chính, nó có thể là 

bên trái, bên phải hoặc có cả hai bên tùy theo theme. Trong một sidebar,  có thể thấy 

các thành phần như Recent Posts, Recent Comments,…các thành phần này được gọi là 

Widget. Cái này chúng ta sẽ tìm hiểu sâu hơn về phần riêng của nó. 

- Post: Mặc định, post được xem như là một bài viết, khi  viết một post và đăng lên 

website thì nó sẽ hiển thị ra website. Đi song hành với Post là Page nhưng Page khác ở 

Post là không được hiển thị ra website khi đăng lên mà nó chỉ hiển thị ra khi người 

dùng truy cập vào đúng địa chỉ của nó. Hai khái niệm này mình sẽ giải thích kỹ hơn về 

sau. 

- Footer: Nghĩa là phần cuối cùng của một website, ở đó sẽ hiển thị các thông tin như 

copyright, giới thiệu,…v…v..phần footer có thể sẽ khác tùy thuộc vào theme. 

 

2 ./ Hiệu chỉnh giao diện 

 

 
 

Thay đổi thông tin giao diện: 

- Site Name & Description: (Nhận dạng site) 
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Thêm và quản lý menu 

- Nhấn vào mục Giao diện/ menu 

- Nhập các  thông tin (tên, chọn trang, chuyên mục đưa vào menu. Nhấn nút Lưu 

 

 
 

Các mục có thể đưa vào menu: 

- Bài viết 

- Liên kết tuỳ chỉnh 

- Chuyên mục 
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Bài tập: 

Tạo menu có cấu trúc: 

- Trang chủ (liên kết URL – web site) 

- Giới thiệu/Tầm nhìn – sứ mệnh 

o Giới thiệu là trang 

o Tầm nhìn – sứ mệnh: chuyên mục 

- Khoá học/ Tiếng Anh/ Thương mại điện tử: các chuyên mục bài viết 

- Tin tức/ Thể thao/ Công nghệ 
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TUẦN 3: CÀI ĐẶT, TUỲ CHỈNH GIAO DIỆN 

 

Cách 1: Cài theme thông qua thư viện 

Chọn Thêm mới (Add theme). Có thể: 

• Tải 1 giao diện từ local host 

• Chọn Theme có sẵn  

 

 
 

Kích hoạt theme 

Chọn theme – Active (kích hoạt) 

Cách 2: Cài theme bằng upload gói theme từ máy tính lên website 

Để cài theme bằng upload gói theme từ máy tính,  cần lưu ý như sau: 

Nén thư mục của theme đó chứ không nén luôn thư mục lồng vào nó. (Ví dụ: khi giải nén ra thì 

theme của  phải có cấu trúc là /tên-theme/style.css1 còn nếu nén file mà nó thành /tên-thư-

mục/tên-theme/style.css là sai) 

Nén file ở dạng file.zip (Nếu ở đuôi khác như.rar, tar là sai). 

Bước 1: Khi có file .zip của theme. 

• Cài đặt trên phiên bản tiếng Anh:  vào Appearance –> Themes –> Add New –

> Upload Theme 

• Cài đặt trên phiên bản tiếng Việt:  vào Giao diện > Giao diện > Thêm mới > Tải giao 

diện lên 

Bước 2:  upload file .zip của theme lên và kích hoạt. Nếu nó báo lỗi missing style.css thì là do  

nén với cấu trúc sai, hãy giải nén ra và nén lại cho đúng nhé 

Cách 3: Cài theme bằng cách upload trực tiếp vào host/ localhost 

⇒ Nếu file bị giới hạn dung lượng upload do theme quá nặng. 

Bước 1:  giải nén ra và upload thư mục theme vào thư mục /wp-content/themes/. 

Lưu ý: Thư mục theme cũng phải có dạng /tên-theme/style.css chứ không phải /tên-thư-

mục/tên-theme/style.css. 

Bước 2: 

• Cài trên phiên bản tiếng Anh: Sau khi upload xong,  vào Appearance > Themes rồi 

kích hoạt vì lúc này theme mà  vừa upload đã hiển thị. 

• Cài trên phiên bản tiếng Việt:  vào Giao diện > Giao diện. 



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 25 | @TaiLieuITIUH 
 

 

Câu hỏi: Theme cài vào website có giống như demo không? 

Nếu muốn cài theme giống như demo thì  cần thực hiện như sau : 

• Thêm menu vào đầy đủ các vị trí trong Appearance > Menus. 

• Thêm các widget cần thiết có hỗ trợ trong theme. 

• Tạo một page với template đặc trưng và tùy chỉnh nó thành Home Page (xem phía 

dưới). 

• Truy cập vào Theme Options của theme (nếu có) và cài đặt những thông số cần thiết 

như Logo chẳng hạn. 

• Truy cập vào Customizer của theme và xem các thông số trong đó (nếu có). 

 

Hãy chắc chắn là website đã có nội dung sẵn 

Trước khi  muốn cài bất kỳ một theme nào đó thì website của  cần bổ sung số lượng nội 

dung bài viết, chuyên mục, menu, hình ảnh,… vì  có nhiều theme yêu cầu  bổ sung chúng.  

Nếu  chưa có nội dung có thể sử dụng Theme Unit Test như sau: 

>>  vào Import >  Tools > Import > WordPress để nó tạo cho  nội dung có sẵn, sau này 

có thể xóa đi nếu  không muốn sử dụng. 

 

Hình 1 . Theme tải miễn phí trên WordPress. 

Đây là một theme miễn phí khác:  https://downloads.wordpress.org/theme/spacious.1.3.7.zip 

https://wpcom-themes.svn.automattic.com/demo/theme-unit-test-data.xml
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Hình 2. Một theme miễn phí khác 

> Nhưng khi  cài ra thì nó chỉ hiển thị như thế này thôi!  

 

Hình 3. Hiển thị của theme khi cài đặt ban đầu 

 thấy nó khác với giao diện ban đầu phải không ?  

Để thay đổi sao cho về giao diện demo  cần: kiểm tra nơi hướng dẫn hoặc tự mày mò cài đặt 

mà không cần hướng dẫn,.. 

• Kiểm tra nơi hướng dẫn 

Những theme đơn giản thì không cần hướng dẫn, còn với dạng theme như trên thì tác giả 

có cả mộtDocumentation luôn cho  lựa chọn. 
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 vào thư viện theme WordPress > Tìm tên theme đó > Sau đó nhấn vào chỗ Theme 

Homepage > sẽ thấy xuất hiện nút Documentation hoặc Tutorial.  

 

Hình 4. Kiểm tra nơi dẫn 

 

Hình 5. Kiểm tra nơi dẫn tại Documentation 

Khi click vào thì tất cả những thông tin hướng dẫn cần thiết  đều có, còn nếu không có 

những từ trên thì  có thể vào Theme Option để kiểm tra xem có đường dẫn nào tới trang 

hướng dẫn không. 

Còn nếu  tìm không ra, thì  có thể làm theo bài hướng dẫn b phía dưới này. 

• Tự cài đặt không cần hướng dẫn 

 vận dụng những kiến thức học WordPress được để thử mày mò xem nhé! 
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Bước 1:  vào Pages > Add New để tạo một Page mới 

Ví dụ: Khi  tạo 2 page là Trang chủ và Blog. Hai trang này  không viết nội dung bên 

trong 

Sau đó,  kiểm tra bên phần Page Template có cái template nào tên Home không, nếu 

không có cái tên nào như thế thì  thử chọn những tên khác, ở theme dưới mình chọn 

là Business Template. Phần nội dung của page  để trống. Sau đó ấn Publish 

 

Hình 6. Kiểm tra Page Template 

Bước 2:  click vào Settings > Reading > chọn A static page > chọn page Home cho 

Front page và page Blog cho Posts page > Sau đó  Save lại 

 

Hình 7.  Chọn  Front page và  Posts page. 

Lưu ý: 
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 kiểm tra khu vực Appearance > Widget để xem cấu trúc sidebar của nó và thêm vào 

một số widget, mỗi sidebar  thêm vào 1, 2 widget gì đó để quan sát. Cũng như Menu  

làm tương tự để thêm các thành phần cần thiết vào nhé! 

 xem qua Theme Option trong Appearance thường thì phần demo họ hướng dẫn để 

theme  có giống như demo hay không nhé! 

  

Hình 8. Demo Theme Option 

Nếu  thấy gần Theme Options có hiển thị Customize thì nhấp vào luôn để xem nó có tùy 

chọn gì không và thử vọc qua hết các tùy chọn đó xem điều gì xảy ra nhé. 

 

Hình 9. Thao tác với tùy chọn trong Customize 

Dưới đây là hệ thống 10 website mua theme WordPress tốt nhất chúng ta có thể tham khảo: 

• Theme Junkies.  

• MyThemeShop 

• ThemeForest 

http://www.theme-junkie.com/
https://mythemeshop.com/
http://themeforest.net/
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• SoloStream 

• ElegantThemes. 

• Templatic. 

• AppThemes. 

• Magazine3. 

• ThemeFoundry. 

• StudioPress. 

 

 

Ví dụ: tài liệu hướng dẫn tài liệu trên theme 

Getting started 

This is the Spacious theme instruction page. We have tried our best to keep it as simple as 

possible. If you think it can be made even simpler let us know we will be glad to change it. 

Let's start! On the right side you can see the table of contents of this documentation.Jump to the 

section you want, or read it all through - your choice.Let's move on! 

02 Installation 

Installing your theme is pretty easy! After downloading you should have a spacious.zip file. 

This is a compressed file containing all of the required templates and images required for the 

theme to function properly. 

Upload the theme 

1. Go to Appearance > Themes in the WordPress Dashboard 

2. Click on the Add New button 

3. Click on the Upload link 

4. Select the spacious.zip file 

5. Click Install Now 

Activate the theme 

1. Go to Appearance > Themes in the WordPress menu 

2. Hover over the theme thumbnail and press the Activate button 

03Custom Menu 

By default, the menus will fall back to Pages. That means just after activation of the theme you 

will see all the pages as menus. If you want selective menus with a combination of links, pages, 

categories then custom menu is what you should be looking for. 

Set up Custom Menu 

1. Go to Appearance > Menus in the WordPress menu 

2. Click on Create a new menu link 

http://www.solostream.com/
http://www.elegantthemes.com/
http://templatic.com/
https://www.appthemes.com/
http://magazine3.com/
https://thethemefoundry.com/
http://www.studiopress.com/
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3. Give a name to your menu in Menu Name and click Create Menu button 

4. Now choose the pages, categories, custom links from the left-side of your screen by 

selecting the checkbox and click on Add Menu 

5. Click Save Menu after adding required pages, categories in the menu 

04Home Page Slider 

This theme supports the home page image slider. To use it follow the steps below. 

1. In the dashboard, go to Appearance->Theme Options. 

2. Go to Slider Tab (on the very right). 

3. To activate the slider, check the Check to activate slider checkbox 

4. Upload the image # 1 for the first slider. Similarly, add the corresponding slider title, 

slider description and redirect link. You can link to a link within your site or outside of 

your site. 

5. Repeat the above step for your other slides. 

6. Then click on Save Changes. That's it, open your home page and it should be there. :) 

05Add custom logo 

Yes, this theme supports custom logo. To use it, follow the below steps. 

1. In the dashboard, go to Appearance->Theme Options->Header Tab. 

2. Upload the custom logo. 

3. Also, the Show logo only or Show both check-box need to be checked to show the logo 

in header. 

4. Click Save Changes. 

06Header Image 

To set the header image follow below steps. 

1. In the dashboard, go to Appearance->Header. 

2. Click on Browse to add your image. Then click on Upload button. 

3. Crop the Image to your liking. The recommended width is 1500px for the header image. 

4. Click Save Changes. 

Note: You can choose the header image to be shown above the header text or below it. 

1. In the dashboard, go to Appearance->Theme Options->Header Tab. 

2. Scroll a bit below and check on the Position Above or Position Below as your like for 

the Header Image Position option. 

3. Click Save Changes. 
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07Setup Business Template 

First Step 

1. In the dashboard, add a new page. 

2. In the Page Attributes option box, choose the Business Template in 

the Templatedrop-down option. 

3. Publish the page. Yes, that's it for the first step. 

Second StepThe Business template has four widget areas within it. Have a look here in this 

image. Click on the image for a better view 

 

1. Business Top Sidebar 

2. Business Middle Left Sidebar 

3. Business Middle Right Sidebar 

4. Business Bottom Sidebar 
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You just need to add some widgets to these sidebars to setup the business template.Third 

StepBelow are some widgets provided by the theme that you could use to make your business 

template look awesome. 

1. TG: Services: Add this widget to Business Top/Bottom Sidebar. In this widget, select 

any of your pages in the drop down option. There are six page drop-down options 

within it. The title, description and featured image of that same pages that you select 

will be shown. 

2. TG: Call to Action: Add this widget to Business Top/Bottom Sidebar. In this widget, 

add the first and second title line, button text, button redirect link and all is done. 

3. TG: Testimonials: Add this widget to any Business Sidebar. In this widgets, add the 

title, text, name, byline and all is done. 

4. TG: Featured Single Page: Add this widget to Business Middle Left/Right Sidebar. In 

this widget, select any of your page in the drop down option. The title, description and 

featured image of that same page that you select will be shown. 

5. TG: Featured Widget: Add this widget to Business Top/Bottom Sidebar. In this 

widget, add the title and description. select any of your page in the drop down option. 

There are three page drop-down options within it. The featured image of that same page 

that you select will be shown. 

Note: If you want to set this Business Page as the Home page, then follow the instruction 

below: 

1. In the dashboard, go to Settings->Reading. 

2. Check on the 'Static Page' option. 

3. Choose the business page (the page you created following the instruction above) as the 

front page. 

4. Save the Changes. 

If you set up everything right you can make your business template look the same as the one on 

our demo page. Business Template 

08How to limit the excerpt text 

Now if you want to reduce or increase the number of words that appear in services widgets or 

post. You can easily change that. 

1. First Go to the service widget page or post in your dashboard. 

2. Just below the page editor you will see the excerpt box 

3. If you don't see the excerpt box. Scroll to the top and you will see the screen 

options on the right hand side corner. 

http://demo.themegrill.com/spacious/
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1. Click it and check the Excerpt box. Now you should see the excerpt box below the 

editor 

2. Fill the excerpt box with the desired amount of text that you want to show. 

09Contact Us Page 

Plugin Installation 

1. Download Contact Form 7 plugin from here Download then install and activate it 

2. Then go to plugin's page and set it. Here is a detail on that Docs 

Contact us page template 

1. Go to dashboard, then create a page. Give it a name "Contact" or "Contact us" as you 

wish. 

2. Now on the right hand side you can see Template Drop-down. Select Contact Page 

Template 

3. Copy the contact form 7 shortcode and paste it in this page. 

4. Click on Publish. 

10How to Setup Blog page? 

You can choose to show blog in 4 different ways. 

1. First go to Settings->Reading->Front Page displays->A static page (select below). 

2. Now from Posts page: dropdown select any page where you like to show blog post. 

3. Click Save Changes. 

4. Now if you want further options then go to Appearance->Theme Options->Design-

>Blog Posts display type. 

5. Choose Blog Image Large for large image with excerpt text. 

6. Choose Blog Image Medium for medium image with excerpt text. 

7. Choose Blog Full Content for showing full content without the featured images and 

readmore 

8. Choose Blog Image Alternate Medium for medium image with excerpt text but 

images appear in alternate fashion right, left. 

9. Now go to Appearance->Menu and select the blog page you choose in step 2 as menu 

http://themegrill.com/wp-content/uploads/2014/03/screen-options.jpg
https://wordpress.org/plugins/contact-form-7/
http://contactform7.com/docs/


Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 35 | @TaiLieuITIUH 
 

Tham khảo thêm: 

http://wpexplorer-themes.com/total/docs/importing-sample-data/ 

BÀI TẬP: 

• Tiến hành upload 2 theme (gửi kèm) và chỉnh sửa sao cho giống các mẫu. 

• Hiển thị nội dung một Page ra trang chủ 

Hướng dẫn 

1. Thiết lập Front Page 

Thiết lập này là để đưa nội dung một Page ra trang chủ. 

Chúng ta hãy làm theo các bước sau: 

• CMS tiếng Anh (hình 1): Vào  Settings -> Reading -> A static page -> Front 

page  chúng ta chọn Page mà chúng ta muốn đưa ra trang chủ. 

• CMS tiếng Việt (hình 2): Vào Cài đặt -> Đọc -> Một trang tĩnh -> Trang chính sau 

đó chúng ta chọn Page mà chúng ta muốn đưa ra trang chủ.   

 

Hình 1. Đưa nội dung 1 page ra Front Page 

http://wpexplorer-themes.com/total/docs/importing-sample-data/
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Hình 2. Đưa nội dung 1 page ra trang chủ 

2. Thiết lập Post Page 

Thiết lập này để hiển thị các bài viết trong một chuyên mục được chỉ định, trong hướng dẫn 

này mình tạo một chuyên mục có tên là Học WordPress 

Để tạo chuyên mục chúng ta hãy vào Admin -> Posts (bài viết) -> Categories (chuyên mục) -

> Add New Category  (Thêm chuyên mục) 

Chúng ta hãy làm theo các bước sau: 

• CMS tiếng Anh (hình 1): Vào  Settings ->  Reading ->  A static page -

>  Post page  chúng ta chọn Pagehọc WordPress vừa tạo 

• CMS tiếng Việt (hình 2): Vào  Cài đặt ->  Đọc ->  Một trang tĩnh ->  Trang bài 

viết sau đó chúng ta chọn Page học WordPress vừa tạo 
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 Hình 4. Thiết lập Posts Page 

  

Hình 5. Thiết lập trang bài viết 
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HƯỚNG DẪN TẠO GALLAREY 

1. Gallery là gì ? 

Gallery là một định dạng hiển thị nhiều kiểu hình ảnh cùng một lúc có thể hiển thị kiểu lưới 

hoặc trình chiếu (slide) tùy theo themes. 

2. Cách tạo và chèn gallery ảnh đơn giản 

Ở bài học trước chúng ta đã biết được chèn và hiển thị từng tấm ảnh trong nội dung với tính 

năng Add Media. Phần nội dung này, chúng ta chèn nhiều tấm ảnh ở dạng gallery, giúp chúng 

ta có thể hiển thị nhiều ảnh được sắp xếp cân xứng và đẹp mắt. 

 >> Lưu ý:tùy theo theme và tính năng này có thể sẽ hiển thị ở những kiểu khác nhau ! 

Sau đây là các bước để tạo gallery ảnh với 2 phiên bản tiếng Anh và tiếng Việt : 

* Cài đặt bản tiếng Anh : 

Bước 1 :  Chúng ta vào Posts > Add New >  Add Media  

 

 

Hình 1. Add New Post và Add Media 

Bước 2 :  Chúng ta chọn Create Gallery > Media Library 

Nếu trong Media Library không có thì chúng ta chọn Select Files để tải lên và chọn Create a 

new gallery 
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Hình 2. Select files trong Media Library 

Bước 3 : Khi màn hình xuất hiện bảng Edit Gallery, chúng ta chọn tiếp nút Insert gallery phía 

cuối hình ảnh (Hình minh họa 3). 

 

Hình 3. Edit Gallery 

Giải thích : 

- Link To: là loại liên kết dẫn tới khi click vào mỗi tấm ảnh, nên chọn Media File để dẫn 

tới liên kết trực tiếp của ảnh gốc. 

- Columns: Số cột hiển thị. 

- Random Order: Hiển thị theo thứ tự ngẫu nhiên sau mỗi lần tải trang. 

- Size: Kích thước ảnh sẽ hiển thị, nên chọn thumbnail cho đẹp. 

Và đây là kết quả của việc tạo ảnh bằng gallery (Hình minh họa 4).   



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 40 | @TaiLieuITIUH 
 

 

Hình 4. Gallery ảnh được chèn vào bài viết 

* Cài đặt bản tiếng Việt : 

Bước 1 : Chúng ta vào Bài viết > Viết bài mới > Thêm Media 

 

Hình 5. Viết bài mới và thêm ảnh trong bộ sưu tập 

Bước 2 : Chúng ta chọn Tạo bộ sưu tập > Thư viện nội dung đa phương tiện (Hình minh 

họa 6) 

 Nếu trong Thư viện nội dung đa phương tiện không có thì chúng ta click vào Chọn tập tin để 

tải lên và chọn tiếp Tạo bộ sưu tập. 
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Hình 6. Tạo bộ sưu tập  

Bước 3: Ở đây xuất hiện hộp Sửa thư viện. Chúng ta chọn ảnh và sau đó click vào Chèn bộ 

sưu tập. 

Ở dưới mỗi bức ảnh chúng ta có thể ghi chú thích của từng ảnh nếu chúng ta muốn. 

 

Hình 7. Sửa thư viện 

Sau khi click Chèn bộ sưu tập thì kết quả của chúng ta sẽ hiển thị ra màn hình như thế này. 
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 Hình 8. Hình ảnh được chèn vào bài viết sau khi tạo bộ sưu tập 

Việc còn lại của chúng ta chỉ cần đăng bài viết là OK 
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TUẦN 4: CÀI ĐẶT CÁC PLUGIN 

Plugin wordpress là gì? 

Plugin là một thành phần mở rộng nhỏ được lập trình riêng dựa trên các API và những 

hàm mở có sẵn của WordPress để tạo thành một tính năng nào đó mà mặc định WordPress 

không có. Nói dễ hiểu hơn, plugin chính là một module bổ sung một chức năng nào đó mà 

chúng ta có thể cài vào WordPress. 

Hiện tại số lượng plugin dành cho WordPress có thể nói là không đếm nổi, chỉ tính 

riêng các plugin chính thức có trên thư viện plugin của WordPress.org thì đã có hàng chục 

nghìn plugin khác nhau, chưa kể còn rất nhiều plugin trả phí khác được bán rải rác trên nhiều 

trang khác nhau. 

 
Tại sao lại cần thiết sử dụng Plugin? 

Có thể nói Plugin giống như sự bổ sung sức mạnh chi tiết cho WordPress, chúng ta 

muốn SEO cho website cũng cần Plugin, muốn tạo Popup cũng cần dùng Plugin hoặc muốn tạo 

tính năng của các trang bán hàng cũng phải sử dụng Plugin…Tất cả những gì chúng ta muốn 

làm trên website đều có thể thực hiện thông qua Plugin, do đó, nó là phần cực kỳ quan trong 

cho sự hoạt động và phát triển của Website WordPress. 

Cách tìm Plugin 

Để tìm Plugin chúng ta làm theo hướng dẫn sau: 

- Với Plugin phiên bản tiếng Anh (hình 1): chúng ta truy cập vào Dashboard –> Plugins 

–> Add New 

- Với Plugin phiên bản tiếng Việt (hình 2): chúng ta truy cập vào Bảng tin –> Gói mở 

rộng –> Cài Plugin mới  
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-  

 

Hình 1: Plugin phiên bản tiếng Anh 
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Hình 2: Plugin phiên bản tiếng Việt 

Húng ta có thể tìm Plugin bằng 2 cách: 

- Cách 1: Thông qua tên bằng cách điền tên ở khung Tìm Plugins bên tay phải rồi Enter 

- Cách 2: Chúng ta xem danh sách các Plugin thông qua các bộ lọc như Nổi 

bật (Featured), Được quan tâm (Popular), Khuyên dùng (Recommended), Yêu 

thích (Favorites). Nếu chúng ta là người mới chúng ta nên chọn qua phần Popular rồi 

cài các Plugin trong đó. 

 

   Hình 3: Thư viện Plugin miễn phí 
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Cách cài đặt Plugin  

Khi chúng ta đã tìm thấy Plugin ưng ý thì cũng đừng vội click vào nút Cập nhật bây 

giờ (Install Now), mà hãy clickvào tên Plugin đó để xem thông tin chi tiết phần mô tả để biết 

Plugin này có chức năng gì, cách cài đặt (Installation) và ảnh chụp (Reviews) như thế nào? 

 

Để biết Plugin đó tốt hay không, chúng ta hãy nhìn vào con số Tải về và đánh giá trung 

bình nếu thấy có điểm số cao, tải về nhiều thì hãy cài đặt vì đã được nhiều người tin tưởng sử 

dụng, và cũng không phải Plugin nào cài vào là cũng làm việc được. Sau khi chắc chắn Plugin 

này chúng ta muốn cài, hãy ấn nút Cập nhật để bắt đầu cài đặt và kích hoạt. 

Một số plugin phổ biến: 

- Akismet  – Chống spam bình luận cực mạnh. 

- Advanced TinyMCE  – Bổ sung các nút soạn thảo vào WordPress. 

- SEO by Yoast  – Hỗ trợ SEO cho WordPress tốt nhất. 

- WP Super Cache  – Tạo bộ nhớ đệm để tăng tốc website. 

- iThemes Security  – Plugin bảo mật thông dụng nhất cho WordPress. 

- Contact Form 7  – Tạo form liên hệ tốt nhất. 

- Responsive Lightbox by 

dFactory 

 – Tạo hiệu ứng lightbox khi click vào ảnh để xem ảnh 

lớn. 

 

3 ./  Sử dụng plugin TinyMCE Advanced. 

 

Plugin WordPress mà mình muốn hướng dẫn chúng ta có tên là: TinyMCE Advanced – 

plugin này có chức năng mở rộng khu vực soạn thảo nội dung thêm phong phú để chúng ta có 

thể viết bài tốt hơn. Bài viết mình chia làm 5 phần chính để chúng ta tiện theo dõi. 

Bước 1: Cài đặt plugin TinyMCE Advanced. 
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Chúng ta sẽ truy cập vào trang >  https://wordpress.org/plugins để tìm hiểu chức năng và xem 

qua thông tin của plugin này nhé. Và không quên gõ vào khu vực tìm plugin là: TinyMCE 

Advanced như ở hình dưới 

 

 

Hình 1. Khu vực tìm kiếm plugin TinyMCE Advanced 

Bước 2: Chúng ta click vào plugin TinyMCE Advanced để xem thông tin chi tiết. 

 

 Hình 2. Thông tin chi tiết plugin TinyMCE Advanced 

Chú giải thông tin trên hình 2: 

- Description: Mô tả - Installation: Cách cài đặt & sử dụng 

- FAQ: Hỏi đáp các câu hỏi thông dụng - Screenshots:  Hình ảnh về plugin 

https://wordpress.org/plugins/
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- Changelog: Lịch sử cập nhật - Support: Gửi hỗ trợ 

- Stats: Thống kê - Reviews: Đánh giá 

- Developers: Nhà phát triển -  

Tùy thuộc vào nhà phát triển, nên không phải plugin nào cũng đủ các thành phần trên. 

Trong những thông tin trên bảng chúng ta cần quan tâm đến phần Description, Installation  và 

Screenshots. 

Cài đặt plugin trên thư viện WordPress.Org 

Bước 1:  

- Cài trên phiên bản tiếng Anh: Chúng ta vào Dashboard > Plugins > Add New và gõ 

tên plugin TinyMCE Advanced 

- Cài trên phiên bản tiếng Việt: Chúng ta vào Bảng Tin > Gói mở rộng > Cài plugin 

mới và gõ tên pluginTinyMCE Advanced 

Bước 2: 

- Cài trên phiên bản tiếng Anh:  Chúng ta Install Now  > Activate plugin đó 

- Cài trên phiên bản tiếng Việt: Chúng ta Cài đặt > Kích hoạt plugin 

 

Hình 3. Tìm kiếm và cài đặt plugin bản tiếng Anh  
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Hình 4. Tìm kiếm và cài đặt plugin bản tiếng Việt 

Tùy chỉnh và thiết lập tùy chọn 

Bước 1: 

o Cài trên phiên bản tiếng Anh: Sau khi chúng ta kích hoạt plugin chúng ta 

vào Setting để xem lại phần cài đặt của mình nhé! 

o Cài trên phiên bản tiếng Việt: Chúng ta vào Cài đặt để xem lại phần mà mình 

vừa cài 

 

Hình 5. Xem lại phần cài đặt TinyMCE Advanced cài trên phiên bản tiếng Anh  
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Hình 6. Xem lại phần cài đặt TinyMCE Advanced cài trên phiên bản tiếng Việt  

Bước 2: Bắt đầu thiết lập 

o Ở cả hai phiên bản WordPress tiếng Việt và tiếng Anh, chúng ta đều chọn 

dòng TinyMCE Advanced và bắt đầu thiết lập. 

Sau khi tùy chỉnh xong chúng ta chọn Save Changes để lưu lại. 

 

Hình 7. Thiết lập cho plugin TinyMCE Advanced 

Kiểm tra lại plugin TinyMCE Advanced 

Sau khi chúng ta đã thiết lập thay đổi trong phần cài plugin TinyMCE Advanced. 

Bây giờ chúng ta quay trở lại mục Posts > Add New để tạo một bài viết mới, tại đây chúng 

ta sẽ thấy những thay đổi trong phần soạn thảo nội dung (những phần mà chúng ta thêm vào 
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thiết lập của TinyMCE Advanced đó). 

 

Hình 8. Sự thay đổi sau khi cài plugin TinyMCE Advanced 

 

4 ./ Sử dụng plugin Contact Form 7 

Plugin Contact Form 7 hiện được đánh giá là plugin có thể phục vụ được một số việc mà 

những plugin trả phí có khi không làm được.  

Tải và cài đặt plugin Contact Form 7 

- Cài trên phiên bản tiếng Việt: Chúng ta vào Gói mở rộng > Cài Plugin mới > Tìm tên 

plugin: Contact Form 7và tiến hành cài đặt 

- Cài trên phiên bản tiếng Anh: Chúng ta vào Plugins > Add New > Tìm tên plugin: Contact 

Form 7 để cài đặt 
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Hình 1.1: Tìm và cài đặt plugin Contact Form 7 

 

Hình 1.2: Xuất hiện biểu tượng hộp thư dành cho Contact 

 

Hướng dẫn tạo form liên hệ 

Để tạo Form chúng ta vào như sau:  

Bước 1:  

- Cài đặt trên phiên bản tiếng Anh: Chúng ta vào Contact > Add New  trên thanh menu 

- Cài đặt trên phiên bản tiếng Việt: Chúng ta vào Contact > Thêm  

 

 

Hình 2.1: Tạo form liên hệ cài trên bản tiếng Anh 
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Hình 2.2: Tạo form liên hệ cài trên bản tiếng Việt 

Bước 2: Tại bước này chúng ta có 2 tùy chọn tạo form. Một là tạo form với ngôn ngữ mặc 

định tương ứng gói ngôn ngữ WordPress chúng ta đang dùng. Hai là tạo form với gói ngôn 

ngữ tùy chọn, chúng ta có thể chọn bên dưới. 

Sau khi ấn nút tạo form, chúng ta sẽ có được cửa sổ như sau: 

- Cài đặt trên phiên bản tiếng Việt: Chúng ta có thể thấy chỗ Biểu mẫu 

 

 

Hình 2.3: Cửa sổ Generate Tag 

∇ Chú thích:  

- Text field: Trường dùng để chúng ta nhập text thông thường, thích hợp tạo field nhập 

tên, tiêu đề liên hệ,… 
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- Email: Trường đặc biệt dùng để khách nhập email của họ vào, lúc đó các hệ thống 

email sẽ hiểu rằng đây là email của người liên hệ để chúng ta ấn reply nhanh chóng 

- URL: Trường dùng để nhập liên kết 

- Telephone Number: Một trường đặc biệt để nhập số điện thoại 

- Number (spinbox): Trường nhập số có thêm tính năng tạo nút tăng/giảm số 

- Number (slider): Trường chọn số đặc biệt, chọn theo kiểu kéo slide, kéo qua phải thì 

số tăng và kéo qua trái thì số giảm 

- Date: Trường riêng biệt để chọn ngày tháng, có tích hợp thêm tính năng chọn theo lịch 

- Text area: Trường để nhập text, nhưng khung text to hơn. Thích hợp để làm form nhập 

nội dung liên hệ 

- Dropdown menu: Trường chọn giá trị được định sẵn thông qua menu đổ xuống 

- Checkboxes: Trường chọn giá trị định sẵn thông qua việc đánh dấu 

- Radio buttons: Cũng là trường đánh dấu giá trị có sẵn nhưng chỉ được chọn một 

- Quiz: Trường nhập nội dung theo kiểu quiz 

- CAPTCHA: Trường nhập mã captcha kiểm tra, nếu nhập đúng thì mới có thể gửi form 

- File upload: Trường cho phép upload tập tin khi gửi liên hệ qua form này 

- Submit button: Chèn nút gửi form 

 Bước 3: Đặt chuột vào khung biểu mẫu – Nhấn vào field mong muốn chỉnh – xuất hiện: 

phần shortcode-form 

1 

2 

<p>Tiêu đề của field (Tên của chúng ta)<br /> 

[shortcode-cua-form] <p> 

Bước 4:  

 Chúng ta copy field trong khung màu xanh bỏ vào khung Mesage body của khung 

Mail phía bên trên. Khung này có ý nghĩa là cài đặt mẫu các thư liên hệ mà khách gửi cho 

chúng ta qua form này. Nếu chúng ta không copy field màu xanh bỏ vào khung bên phải của 

phần Mail thì chúng ta sẽ không thể thấy nội dung mà khách nhập vào trong field đó. (Cài 

đặt trên 2 phiên bản tương tự nhau nên mình chỉ lấy một hình) 
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Hình 2.4. Copy đoạn shortcode 

» Sau khi  chúng ta chỉnh xong, chúng ta nhớ Lưu lại ( Save )nhé! 

1. Chèn form vào post/page 

Bước 1: Copy đoạn shortcode của form 

 Sang phần chèn Form này, chúng ta chỉ cần copy code trong khung màu tím ngay dưới tiêu 

đề form  

 

Hình 2.5: Copy đoạn shortcode của form 

Bước 2: Paste vào nội dung của post/page 
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Hình 2.6: Paste shortcode của form vào nội dung post/page 

 

Cài đặt và sử dụng Akismet 

Spam luôn là vấn đề nan giải với những mã nguồn mở như WordPress. 

Thực tế, khi những mã nguồn website mở trở nên thông dụng luôn là mục tiêu của các 

spammer tấn công. Nhưng không phải vì thế mà chúng ta bó tay với spam nhất là đối với mã 

nguồn như WordPress. Bởi hiện nay có rất nhiều cách để chống spam. 

Nhà phát triển Automattic đã đưa ra plugin Akismet – plugin chống spam hoàn toàn miễn phí 

dành cho WordPress.  

Bước 1: Khi chúng ta cài đặt xong WordPress, họ đã cung cấp sẵn cho chúng ta plugin tên 

Akismet. Để cài đặt chúng ta làm theo hướng dẫn sau 

• Cài đặt trên phiên bản tiếng Anh: Dashboard > Plugins > Installed Plugins. 

• Cài đặt trên phiên bản tiếng Việt: Bảng tin > Gói mở rộng > Các gói mở rộng đã cài 

đặt. 

Bước 2: Kích hoạt plugin Akismet. 

• Cài đặt trên phiên bản tiếng Anh: Chúng ta click vào nút Activate Your Akismet 

Account để kích hoạt. (Hình 3) 

• Cài đặt trên phiên bản tiếng Việt: Chúng ta click vào nút Kích hoạt tài khoản Akismet 

Account để kích hoạt nhé. (Hình 4) 
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Hình 4: Kích hoạt plugin Akismet phiên bản tiếng Việt. 

Bước 3: Lấy khóa API 

• Cài đặt trên phiên bản tiếng Anh: Chúng ta ấn vào nút Get you API key để lấy khóa 

API riêng. (Hình 4) 

• Cài đặt trên phiên bản tiếng Việt: Chúng ta ấn vào nút Get you API key để lấy khóa 

API riêng. (Hình 5) 

  

Hình 5.  Lấy khóa API trên phiên bản tiếng Anh. 



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 58 | @TaiLieuITIUH 
 

 

Hình 6.  Lấy khóa API trên phiên bản tiếng Việt. 

Bước 4: Chúng ta sẽ được chuyển tới trang chủ Akismet, chúng ta ấn vào nút Get an Akismet 

API key (Cả 2 phiên bản tiếng Việt và tiếng Anh đều giống nhau nên mình chỉ lấy 1 hình) 

 

Hình 7. Chúng ta sẽ được chuyển tới trang chủ Akismet. 

Bước 5: Đăng nhập tài khoản wordpress.com và chọn gói. 
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• Chúng ta cần đăng nhập vào tài khoản wordpress.com của chúng ta rồi cấp quyền nó 

truy cập dịch vụ Akismet (Nếu chưa có tài khoản chúng ta đăng ký tài khoản tại 

wordpress.com). Sau đó, chúng ta cấp quyền nó truy cập dịch vụ Akismet. 

• Họ sẽ hỏi chúng ta chọn gói nào > hãy chọn Personal để dùng miễn phí. 

 

Hình 8. Đăng nhập tài khoản wordpress.com và chọn gói. 

Bước 6: Lại một lần nữa họ mời chúng ta ủng hộ kinh phí. Chúng ta có thể kéo thanh ngang về 

số O và điền First name & Last name > Continue. 

  

Hình 9. Điền thông tin của chúng ta vào  

Bước 7: Chúng ta sẽ nhận được key như thế này. Hãy copy key này rồi mở tab trang của chúng 

ta chọn Settings > Akismet. 
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Hình 10. Lấy key 

Bước 8: Chúng ta paste Key vừa lấy vào khung của  Manually enter an API key > Use this 

key. 

 

Bước 9: Và bây giờ thì chúng ta hãy nói lời tạm biệt với spam và Spammer nha! 
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TUẦN 5 – PLUGIN (TIẾP) 

 

4/Plugin Responsive Lightbox by dFactory 

Hiệu ứng Lightbox cho ảnh chính là hiệu ứng mà khi chúng ta nhấp vào một tấm ảnh nó sẽ 

hiển thị ra một cửa sổ pop up nhỏ để hiển thị kích thước thật của ảnh đó từ việc sử dụng một 

plugin trong jquery.  

Cài đặt và kích hoạt plugin Responsive Lightbox by dFactory 

Tìm tên hiệu ứng và cài đặt: 

• Cài đặt trên phiên bản tiếng Anh: Chúng ta tìm tên plugin Responsive Lightbox by 

dFactory > Install Now> Activate Plugin 

• Cài đặt trên phiên bản tiếng Việt: Chúng ta tìm tên plugin Responsive Lightbox by 

dFactory > Cài đặt plugin > Sau đó Kích hoạt plugin này 

Vì hình ảnh gần tương tự nên mình lấy ảnh của phiên bản tiếng Việt để chúng ta dễ nhìn 

 

Hình 1. Tìm và cài đặt kích hoạt plugin Responsive Lightbox by dFactory 

» Sau khi kích hoạt xong chúng ta chuyển sang phần thiết lập cho plugin này. 

1. Thiết lập plugin Responsive Lightbox by dFactory 

Để thiết lập chúng ta vào như sau: 

- Cài đặt trên phiên bản tiếng Anh: Chúng ta vào Setting > Chọn Responsive Lightbox 

by dFactory > Trong General settings chọn kiểu hiệu ứng như: prettyPhoto, SwipeBox, 

FancyBox, Nivo Lightbox, Image Lightbox. 
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- Cài đặt trên phiên bản tiếng Việt: Chúng ta vào Cài đặt > Chọn Responsive Lightbox 

by dFactory > Trong General settings chọn kiểu hiệu ứng như: prettyPhoto, SwipeBox, 

FancyBox, Nivo Lightbox, Image Lightbox. 

 

 

 

Hình 2. Thiết lập plugin Responsive Lightbox by dFactory trên phiên bản tiếng Anh 

∇ Giải thích trong tab General Settings:  

- Lightbox script: Chọn hiệu ứng lightbox kịch bản ưa thích của chúng ta 
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- Selector: Chọn rel  lightbox hiệu ứng sẽ được áp dụng 

- Galleries: Thêm lightbox để trưng bày hình ảnh WordPress mặc định. 

- Gallery image size: Theo mặc định liên kết WP gallery để chỉ hình ảnh kích 

thước đầy đủ. Kích hoạt tính năng đó để thay đổi kích thước hình ảnh của WP 

thực liên kết hình ảnh trong bộ sưu tập. 

- Video links: Thêm lightbox lên YouTube và Video liên kết video bằng cách mặc 

định. 

- Image links: Thêm lightbox để WordPress liên kết hình ảnh theo mặc định. 

- Single images as gallery: Hiển thị hình ảnh bài duy nhất là một bộ sưu tập. 

- Custom events: Kích hoạt tính năng kích hoạt lightbox trên các sự kiện tùy chỉnh 

jquery. 

- Loading place: Chọn nơi mà tất cả các kịch bản lightbox nên được đặt. 

- Deactivation: Xóa thiết lập trên các plugin  
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Hình 3. Thiết lập plugin Responsive Lightbox by dFactory trên phiên bản tiếng Việt 

Ở hình 3 phần Tab  General Settings phiên bản tiếng Việt cũng tương tự như phiên bản 

tiếng Anh nên mình không giải thích nữa. 

 » Sau khi thiết lập thì chúng ta Save changes lại. 

Để ảnh có thể hiển thị lightbox trong ảnh khi nhấp vào, khi chèn ảnh vào WordPress 

chúng ta nên lưu ý chỗ phần Link to phải để là Media File 

 

Vi dụ khi mình upload một loạt ảnh trong máy tính lên và chọn 1 ảnh bất kỳ đăng trong 

bài viết > Sau đó mình click vào ảnh thì nó sẽ hiển thị phần tạo hiệu ứng ảnh như này  
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Ngoài plugin trên chúng ta có thể dùng lightbox hỗ trợ khác như  WP Lightbox 2 chẳng 

hạn. 

5/ Plugin WordPress SEO - WordPress SEO by Yoast 

SEO (từ viết tắt của Search Engine Optimization – Tối ưu hóa công cụ tìm kiếm) là một 

tổ hợp hay tập hợp các phương pháp bao gồm kỹ thuật, chiến thuật của Marketing và Công 

nghệ internet nhằm nâng cao thứ hạng (Ranking hay vị trí trên top cao của trang đầu tiên khi 

tìm kiếm) của một website hay trang web cụ thể trong các trang kết quả của các công cụ tìm 

kiếm mà phổ biến nhất là Google. 

SEO là vô cùng cần thiết, là một trong những chìa khóa quan trọng nhất trong việc thu 

hút người dùng đến với website của chúng ta. Nếu như người quản trị web không có được ít 

nhất những kiến thức về cơ chế hoạt động, phương thức SEO, trang web của họ sẽ không bao 

giờ có được nhiều người biết đến. 

Tải và cài đặt plugin WordPress SEO 

Ở những bài trước – bài 26, mình đã hướng dẫn cài đặt plugin, chúng ta có thể quay lại Case 

Study để xem lại nếu chúng ta quên cách cài đặt. Tên của plugin này là WordPress SEO by 

Yoast, nó được viết bởi Joost de Valk. 

Dưới đây là các bước tìm và cài đặt WordPress SEO by Yoast: 

Bước 1: Chúng ta vào Pugins > Add new > Tìm kiếm tên WordPress SEO by 

Yoast > Install Now 

 

Hình 1. Tìm kiếm SEO by Yoat. 

Bước 2: Chọn Activate Plugin để cài đặt. (). 
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Hình 2. Tìm kiếm SEO by Yoat 

Sau khi kích hoạt thì chúng ta sẽ thấy trên thanh điều khiển có SEO và các mục con của nó 

như: General, Titles & Metas, Social, XML Sitemaps, …. 

 

Hình 3. Tìm kiếm SEO by Yoat. 

>> Khi chúng ta vừa mới kích hoạt plugin thì hệ thống sẽ đưa ra màn hình một thông báo 

hỏi chúng ta có muốn cho phép plugin thu thập thông tin và gửi đến tác giả của nó hay 

không, cái này thì tùy ở chúng ta, cho phép cũng được mà không cho phép cũng được. 

Dưới đây là hình ảnh trên thanh điều khiển có biểu tượng chữ SEO, chúng ta hãy nhấn vào 

menu này để chuyển sang khung của plugin WordPress. 
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Hình 4. Bảng thông tin khi cài đặt xong. 

Cấu hình chi tiết cho plugin WordPress SEO  

Đây là bảng cài đặt chính cho plugin WordPress SEO, trong menu sẽ bao gồm những thông tin 

chung về quyền sử dụng chức năng SEO, tùy chọn cho phép tác giả thu thập thông tin quá trình 

hoạt động của plugin, các mục cho phép chúng ta nhập mã xác thực của những công cụ hữu 

ích. Trong những mục này, chỉ có phần Security là quan trọng nhất. 

1.General 

 

Hình 5. Bảng thông tin General. 

∇ Giải thích: 

- Tracking (hay còn gọi là theo dõi): Để duy trì một plugin lớn như WordPress SEO, 

chúng ta cũng cần phải biết những gì tác giả đang làm việc như loại plugin khác mà 
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người dùng đang sử dụng, những chủ đề,… Tác giả mong muốn theo dõi các dữ liệu 

từ các cài đặt của chúng ta nhưng không bao gồm chi tiết người dùng, vậy nên an 

ninh và riêng tư của chúng ta luôn được an toàn. Chúng ta có thể tích vào ô “Allow 

tracking of this WordPress install’s anonymous data” hoặc không. 

- Introduction Tour: Giới thiệu Tour. Chúng ta có thể click vào Start Tour để tìm hiểu 

về việc sử dụng các plugin WordPress SEO 

- Restore Default Settings: Khôi phục cài đặt mặc định. Nếu chúng ta muốn khôi phục 

lại một trang web mặc định của WordPress SEO thiết lập, thì chúng ta nhấn 

nút Restore Default Setting. 

 

2.Title và Metas 

Đây là mục quan trọng mà hầu hết chúng ta cần đến để cài đặt và sử dụng plugin WordPress 

SEO. 

a. Tab General  

Hình ảnh dưới đây ta có thể thấy có 2 mục là Force rewrite titles và Title Separator 

 

Hình 6. Thẻ Title & Metas. 

∇ Giải thích:  

- Force rewrite titles: Là chức năng viết lại tiêu đề của giao diện bài viết, nhưng nhiều 

lúc nó sẽ làm thay đổi tiêu đề của một trang mà tiêu đề này không như mong muốn 

của chúng ta. (Mình khuyên chúng ta không nên sử dụng chức năng này, chúng ta có 

thể để hàm tiêu đề về trạng thái đơn giản trong tập tin header.php của giao diện). 

- Title Separator: Chọn biểu tượng để sử dụng như là tiêu đề phân cách của chúng ta. Ví 

dụ, giữa tiêu đề bài viết của chúng ta và tên trang web, biểu tượng được thể hiện 

trong các kích cỡ mà họ sẽ xuất hiện trong kết quả tìm kiếm. 

https://hoangluyen.com/gioi-thieu/
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b. Homepage 

 

Hình 7. Homepage trong Title & Metas. 

∇ Giải thích: 

- Title template: Là dòng mô tả ngắn của blog. Ở đây thì chúng ta nên để theo dạng tên 

của blog. 

- Meta description template: Là phần mô tả cho trang chủ của blog. Chúng ta viết mô tả 

ngắn gọn nhưng phải diễn đạt được hết nội dung trên blog của chúng ta nhé! Sau 

đó Save changes lại. 

c. Post Types 
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Hình 8. Post Types trong Title & Metas. 

∇ Giải thích:  

- Posts và Pages: có các ô checkbox thì chúng ta hãy để trống nhé. 

- Media: thì chúng ta chọn vào ô Meta Robots để cho các công cụ tìm kiếm không 

index các trang hình ảnh vì nó không có ích cho lắm. 

- Đối với các ô checkbox của Posts và Pages thì chúng ta hãy để trống, riêng phần 

Media thì chúng ta chọn vào ô Meta Robots để cho các công cụ tìm kiếm không 

index các trang hình ảnh vì nó không có ích cho lắm. 

- Taxonomies: Trong mục này thì chúng ta chỉ cấu hình cho phép các công cụ tìm 

kiếm index mỗi phần Categories mà thôi. Đối với Tags và Format thì chúng ta chọn 

noindex, follow.  

- Other: Thiết lập meta trên toàn site. 

- Author Archives: Chúng ta có thể kích hoạt lại nếu sau này trang blog của chúng ta 

có sự tham gia của nhiều tác giả. Chúng ta có thể tùy chỉnh lại tiêu đề mặc định cho 

trang tìm kiếm và trang báo lỗi 404 nếu cần. 

3. Social 
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Hình 9. Tab Social 

∇ Giải thích: 

Menu Social sẽ bao gồm những thông tin cài đặt về mạng xã hội, chúng ta có thể thêm tài 

khoản Facebook, Twitter, Pinterest, Google vào phần cấu hình SEO cũng như thêm địa chỉ 

Fanpage blog của chúng ta. 

4. XML Sitemaps 

 

 

Hình 10. XML Sitemaps 

∇ Giải thích: 

Đây là một chức năng tuyệt vời của plugin, nó đáp ứng được nhu cầu tạo sitemap trên trang của 

chúng ta. Nếu chúng ta sử dụng chức năng sitemap thì hãy loại bỏ không 

cho Media và Format hiển thị trong sitemap, còn đối với tag thì chúng ta có thể bỏ hoặc 

không. Chúng ta nhớ lưu lại phần thiết lập này và chuyển sang phần cài đặt Advanced. 

https://hoangluyen.com/phan-mem-download-video-facebook/
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5. Advanced 

 

 

Hình 11. Advanced. 

∇ Giải thích: Trong phần Advanced có 3 tab chính đó là Breadcrumbs, Permalinks, RSS 

- Breadcrumbs: Chúng ta có thể đặt Breadcrumbs lên trên phần header, khi người dùng 

truy cập xem bài viết hoặc một trang nào đó thì hệ thống sẽ hiển thị thông tin của bài 

viết, bao gồm chuyên mục và các đường link bên trên, khi chúng ta tìm kiếm trên 

Google thì những đường link này sẽ hiển thị bên dưới dòng tiêu đề của kết quả tìm 

kiếm. Nó sẽ giúp trang blog của chúng ta có nhiều lượt visit hơn khi người dùng tìm 

kiếm trên Google cũng như các công cụ tìm kiếm khác. 

Chúng ta có thể thay thế lại biểu tượng phân cách giữa các đường link và đặt tên cho 

trang chủ. Chúng ta chép đoạn code bên dưới và đặt vào nơi mà chúng ta 

muốn breadcrumbs xuất hiện. 

-  
1 

2 

3 

<?php if ( function_exists('yoast_breadcrumb') ) { 

yoast_breadcrumb('<p id="breadcrumbs">','</p>'); 

} ?> 

- Permalinks có một chức năng rất hay đó là chúng ta có thể xóa đi từ /category trong 

đường dẫn của chuyên mục. Chúng ta cũng có thể xóa đi từ ?replytocom ra khỏi đường 

link trả lời bình luận khiến cho đường dẫn trên blog của chúng ta dễ nhìn và thân thiện 

với SEO hơn. 

- RSS: Cài đặt thông tin cho RSS. Chúng ta có thể tùy chỉnh nội dung mail của như thêm 

hoặc bỏ đi thông tin hiển thị phía đầu hoặc phía cuối nội dung mail. 
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6. Tools 

 

Hình 12. Tools.  

∇ Giải thích:  

Trong Tool có công cụ tích hợp rất mạnh mẽ đó là: Bulk editor, File editor, Import and 

Export. 

- Bulk editor: Là biên tập hàng loạt. Công cụ này cho phép chúng ta nhanh chóng thay 

đổi tiêu đề và mô tả của bài viết và trang của chúng ta mà không cần phải đi vào trình 

soạn thảo. 

- File editor: Công cụ này cho phép chúng ta nhanh chóng thay đổi các tập tin quan trọng 

cho SEO của chúng ta, giống như robots.txt của chúng ta, và nếu chúng ta có một, tập 

tin .htaccess. 

- Import and Export: Là xuất và nhập. Nhập cài đặt từ các plugin SEO khác và xuất khẩu 

các thiết lập của chúng ta tái sử dụng trên (khác) blog. 
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7. Extensions 

 

Hình 13. Extensions 

∇ Giải thích:  

Trên hình ảnh gồm 2 tab là Extensions và Licenses 

- Extensions: Chúng ta có thể chọn một số ứng dụng hỗ trợ giúp cho trang của chúng ta 

SEO dễ dàng như: WorPress SEO Premium, Video SEO, New SEO, Local SEO 

- Licenses: Đây là nơi chúng ta sẽ nhập các phím giấy phép cho một trong những plugin 

cao cấp của chúng tôi, chúng ta nên kích hoạt một. 

Sử dụng SEO cho Chuyên mục, Thẻ, Bài viết và Trang 

Bốn yếu tố quan trọng với một blog sử dụng WordPress đó là Chuyên mục, Thẻ, Bài viết, 

Trang 

Nếu chúng ta không thấy form hỗ trợ SEO của plugin thì có thể bật nút Screen Options bên góc 

trên bên phải màn hình để chọn hiển thị form của plugin. 
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Hình 14. Bật công cụ SEO tại Screen Options 

1. Với Chuyên mục chúng ta có thể thêm thông tin SEO cho chuyên mục như hình 13 dưới 

đây :  

 

Hình 15. Thêm thông tin SEO cho chuyên mục 

2. Với Thẻ chúng ta có thể thêm thông tin SEO cho thẻ như hình 14 dưới đây: 
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 Hình 16. Thêm thông tin cho thẻ. 

 

3. Với Thêm bài viết mới chúng ta có thể thêm thông tin SEO cho thẻ như hình 15 dưới 

đây: 
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Hình 17. Thêm thông tin cho bài viết mới 

4. Với Trang chúng ta có thể thêm thông tin SEO cho trang như hình 16 dưới đây: 
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Hình 18. Thêm thông tin cho trang. 

∇ Nếu như chúng ta có sử dụng từ khóa trọng tâm (Focus Keyword) thì plugin sẽ thông báo 

trạng thái SEO của bài viết hoặc trang chúng ta đang tạo, nếu như màu cái nút tròn màu xám 

có nghĩa là chúng ta không dùng từ khóa trọng tâm, nếu nút màu đỏ có nghĩa là chúng ta 

SEO không tốt, nếu như nút chuyển sang màu đỏ hơi cam thì chúng ta làm SEO chưa tốt, 

nếu như nút đó chuyển sang màu xanh hơi vàng thì chúng ta làm SEO tương đối tốt, cuối 

cùng cái nút trạng thái chuyển sang màu xanh lá thì coi như bài viết hoặc chuyên mục có 

khả năng SEO rất tốt. 

 

 

Hình 19. Đánh giá khả năng SEO của bài viết 

 

6/ Plugin Xuất/Nhập (Import/Export) các dữ liệu post 

Trong bài học này mình sẽ hướng dẫn chúng ta cách Xuất/Nhập các dữ liệu để chúng ta làm 

quen với việc sao lưu dữ liệu khi muốn khôi phục lại các dữ liệu đó. Hãy tìm hiểu cùng tôi nào! 

6.1 Xuất (Import) nội dung 

Để xuất nội dung chúng ta làm theo hướng dẫn sau: 

- Với phiên bản tiếng Anh (hình 1): Chúng ta truy cập vào Dashboard –> Tools –> Export 
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- Với phiên bản tiếng Việt (hình 2): Chúng ta truy cập vào Bảng tin –> Công cụ –> Xuất ra 

 

Hình 1: Trang Xuất nội dung với phiên bản tiếng Anh  

 

Sau đó chúng ta có thể chọn loại nội dung để xuất, bao gồm: 

- All Contents: Xuất toàn bộ nội dung liên quan tới Post và Page, Menu… 

- Posts: Xuất toàn bộ nội dung liên quan tới Post. 

- Pages: Xuất toàn bộ nội dung liên quan tới Page. 

Sau khi chọn loại nội dung xong chúng ta ấn vào nút Download Export File, nó sẽ tải về 

máy một tập tin có định dạng.xml chứa dữ liệu mà chúng ta xuất ra. Tập tin này có lớn 

hay không tùy thuộc dữ liệu có nhiều nội dung hay không. 
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Hình 2: Trang Xuất nội dung với phiên bản tiếng Việt 

Sau đó chúng ta có thể chọn loại nội dung để xuất, bao gồm: 

- Tất cả nội dung: Xuất toàn bộ nội dung liên quan tới Bài viết và Trang, Menu… 

- Bài viết: Xuất toàn bộ nội dung liên quan tới Post. 

- Trang: Xuất toàn bộ nội dung liên quan tới Page. 

- Cũng tương tự, khi chúng ta chọn loại nội dung xong chúng ta ấn vào nút Tải về tập tin 

được xuất ra, nó sẽ tải về máy một tập tin có định dạng.xml chứa dữ liệu mà chúng ta 

xuất ra. 

6.2 Nhập (Export) nội dung 

Với tập tin .xml mà chúng ta đã xuất ra bằng WordPress, chúng ta có thể nhập lại nội dung 

vào bất kỳ website nào sử dụng WordPress. Để nhập nội dung chúng ta làm theo hướng dẫn 

sau: 

- Với phiên bản tiếng Anh (hình 3): Chúng ta truy cập vào Tools –> Import và 

chọn WordPress. 
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- Với phiên bản tiếng Việt (hình 7): Chúng ta truy cập vào Công cụ –> Nhập vào và 

chọn WordPress. 

 

Hình 3: Trang Nhập nội dung với phiên bản tiếng Anh  

Khi chúng ta ấn vào WordPress nó sẽ hỏi chúng ta cài plugin WordPress Import nếu 

Website chúng ta chưa có plugin này, hãy ấn Install  như cài một plugin thông thường, còn 

nếu không nó sẽ hiển thị luôn như hình dưới đây. Sau đó, chúng ta chọn tập tin .xml chứa 

dữ liệu của chúng ta ở máy tính và ấn nút Upload file and Import để bắt đầu nhập dữ liệu. 

 

Hình 4: Trang Nhập nội dung với phiên bản tiếng Anh 

Sau đó, nó sẽ hỏi chúng ta chỉ định nội dung được nhập vào cho một người dùng nào đó trên 

website hoặc tạo mới, chúng ta chọn cái nào cũng được. Nhớ đánh dấu vào nút Download 

and import file attachments để nó tải các hình ảnh/media từ website đã xuất ra và bỏ lên 

website được nhập vào. Cuối cùng là ấn vào nút Submit để nhập nội dung. 
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 Hình 5: Trang Nhập nội dung với phiên bản tiếng Anh 

Khi nhập vào, nếu nội dung nào đã có trên website chúng ta rồi thì nó sẽ bỏ qua và chỉ nhập 

các nội dung mới. 

 

Hình 6: Trang Nhập nội dung với phiên bản tiếng Anh 

Cuối cùng chúng ta ấn nút Have fun! để trở lại Dashboard. 

Tiếp theo đây là hướng dẫn với phiên bản tiếng Việt: 
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 Hình 7: Trang Nhập nội dung với phiên bản tiếng Việt 

Khi chúng ta ấn vào WordPress nó sẽ hỏi chúng ta cài plugin WordPress Import nếu Website 

chúng ta chưa có plugin này, hãy ấn Cài đặt  như cài một plugin thông thường, còn nếu không 

nó sẽ hiển thị luôn như hình dưới đây. Sau đó, chúng ta chọn tập tin .xml chứa dữ liệu của 

chúng ta ở máy tính và ấn nút Tải tập tin lên và nhập để bắt đầu nhập dữ liệu. 

 

Hình 8: Trang Nhập nội dung với phiên bản tiếng Việt 

Nó sẽ hỏi chúng ta chỉ định nội dung được nhập vào cho một người dùng nào đó trên website 

hoặc tạo mới, chúng ta chọn cái nào cũng được. Nhớ đánh dấu vào nút Download and import 

file attachments để nó tải các hình ảnh/media từ website đã xuất ra và bỏ lên website được 

nhập vào. Cuối cùng là ấn vào nút Submit để nhập nội dung. 
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Hình 9: Trang Nhập nội dung với phiên bản tiếng Việt 

Khi nhập vào, nếu nội dung nào đã có trên website chúng ta rồi thì nó sẽ bỏ qua và chỉ nhập các 

nội dung mới, còn nếu không thì nó sẽ nhập hết. 

 

Hình 10: Trang Nhập nội dung với phiên bản tiếng Việt 

Cuối cùng chúng ta ấn nút Have fun! để trở lại Bảng tin. 

Lưu ý khi nhập nội dung: 

Khi nhập nội dung, không phải lúc nào nó cũng được suôn sẻ thế này, nhất là đối với các 

website có nhiều nội dung. Một số lưu ý sau để nếu chúng ta có gặp thì không phải suy nghĩ nó 

bị lỗi gì: 

- Nếu các tập tin .xml có dung lượng lớn và chúng ta nhập trên một website WordPress 

chạy trên host (không phải localhost) thì có thể bị lỗi timeout vì quá thời gian chờ đợi. 

Chúng ta chỉ cần import 2, 3 lần là xong. 
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- Các hình ảnh sẽ không được tải về thành công nếu website xuất ra đã xóa ảnh đó hoặc 

không còn hoạt động. 

- Khi nhập nội dung, hãy chú ý cái chữ Maximum Upload Size, đó là dung lượng tối đa 

của tập tin mà chúng ta được phép upload. Tùy theo host mà dung lượng này sẽ lớn 

hoặc nhỏ, nhưng sau này chúng ta dùng host thì thường sẽ là 25 – 100MB. 
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TUẦN 6: PLUGIN WOOCOMMERCE 

 

Woocommerce là plugin gì? 

Woocommerce là một plugin miễn phí được sử dụng để tạo một trang thương mại điện tử cỡ 

nhỏ tốt nhất hiện nay trong WordPress. Nó cũng như bao plugin khác là bổ sung chức năng vào 

website nhưng nó sẽ bổ sung gần như toàn diện các chức năng mà một trang bán hàng đơn giản 

cần có. 

Woocommerce sẽ có các chức năng chính như: 

• Tạo sản phẩm với định dạng thông thường, sản phẩm có thuộc tính, sản phẩm affiliate 

và sản phẩm kỹ thuật số (có thể tải về). 

• Hỗ trợ một số hình thức thanh toán online như PayPal, Credit Card, CoD, Cash và sẽ 

càng nhiều hơn khi cài thêm plugin hỗ trợ cho riêng nó. 

• Hỗ trợ tự tính thuế sản phẩm hoặc thuế theo đơn hàng. 

• Hỗ trợ tự tính giá chuyển phát, có rất nhiều loại tính giá chuyển phát và sẽ đa dạng hơn 

khi cài thêm plugin như có thể tính giá chuyển phát dựa theo cân nặng, kích thước, tỉnh 

thành,… 

• Trang quản lý đơn hàng chuyên nghiệp, lọc đơn hàng thông qua từng trạng thái. 

• Hỗ trợ template hiển thị riêng để có thể tự cấu hình lại template hiển thị phần shop và 

sản phẩm, cái này rất có lợi cho lập trình viên. 

• Có sẵn nhiều theme và extension (plugin mở rộng) để biến thành trang shop chuyên 

nghiệp. 

Cài đặt và thiết lập Woocommerce cơ bản 

Trước tiên chúng ta tìm plugin tên Woocommerce trong Dashboard và cài 

plugin tên WooCommerce – excelling eCommerce rồi cài nó. 

http://www.woothemes.com/woocommerce/
http://thachpham.com/wordpress/wordpress-tutorials/tim-va-cai-plugin.html
http://thachpham.com/wordpress/wordpress-tutorials/tim-va-cai-plugin.html
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Tìm plugin “Woocommerce” trên thư viện 

Sau khi cài đặt thì kích hoạt như bình thường. Sau khi kích hoạt nó sẽ chuyển thẳng 

chúng ta đến trang thiết lập ban đầu cho Woocommerce. Hãy ấn vào nút Cài đặt bản dịch để nó 

cài bộ ngôn ngữ phù hợp cho website, ví dụ chúng ta đang dùng WordPress tiếng Việt thì nó sẽ 

cài bản dịch tiếng Việt cho Woocommerce. Sau đó ấn nút Bắt đầu. 
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Cài đặt bản dịch và thiết lập cho Woocommerce 

Kế đến là bước cài đặt trang cần thiết cho Woocommerce, ở đây nó sẽ cài một số trang 

bắt buộc như Cửa hàng, Giỏ hàng, Thanh toán,…vì nếu không có các trang này thì sẽ không 

hoàn thiện được. Do vậy ta sẽ ấn nútTiếp tục. 
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Cài đặt trang cần thiết cho Woocommerce 

Kế tiếp là cài đặt vị trí cửa hàng, ở đây chúng ta sẽ cài đặt quốc gia của cửa hàng chúng ta, loại 

tiền tệ, định dạng tiền tệ. Nếu chúng ta thiết lập cho cửa hàng tại Việt Nam thì nên thiết lập như 

ảnh dưới. 
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Thiết lập vị trí và định dạng tiền tệ phù hợp với Việt Nam. 

Ở bước cài đặt vận chuyển và thuế chúng ta cứ ấn Tiếp tục mà không cần chọn gì nhé, cái này 

chúng ta sẽ thiết lập kỹ hơn ở mục riêng của nó. Sau khi thiết lập xong thì quay lại trang quản 

trị. 
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Ngoài ra chúng ta còn một bước cuối nữa là chỉnh lại định dạng tiền tệ một chút nữa để cho nó 

phù hợp nhất với định dạng tiền tệ Việt Nam, đó là xóa 2 số 0 ở cuối đi. Chúng ta hãy vào 

Woocommerce -> Cài đặt. 
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Sau đó ở tab Chung, chúng ta sửa thành 0 ở phần Số đơn vị thập phân. 
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Bỏ số đơn vị thập phân ở tiền tệ 

Bây giờ giá tiền của sản phẩm sẽ hiển thị chính xác là 150.000 nếu chúng ta nhập giá là 

150000. 

Mặc định sau khi cài xong Woocommerce, chúng ta vào phần quản lý trang (Pages) sẽ 

thấy có một số trang mặc định mà Woocommerce tự tạo ra để có thể sử dụng các chức năng 

cần thiết trên trang bán hàng. 

http://thachpham.com/wordpress/wp-plugin/cai-dat-woocommerce-va-thiet-lap-co-ban.html
http://thachpham.com/series/hoc-woocommerce
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Các trang mặc định của Woocommerce 

Ở đây bao gồm: 

• Cửa hàng: Trang này sẽ hiển thị các sản phẩm mới nhất trên website và có phân trang. 

• Giỏ hàng: Trang này sẽ là trang giỏ hàng của chúng ta khi thêm hàng vào giỏ, nó sẽ 

hiển thị các sản phẩm có trong giỏ hàng. 

• Tài khoản của tôi: Đây là trang quản lý tài khoản của khách hàng nếu họ đăng nhập 

vào website. 

• Thanh toán: Trang thanh toán đơn hàng, hay còn gọi là trang Checkout  

Trong đó, trang Cửa hàng sẽ được thiết lập ở Woocommerce -> Cài đặt -> Sản phẩm -> Hiển 

thị. 
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Các trang còn lại tuy không thiết lập ở đây nhưng để nó hoạt động thì nội dung phải cần có 

các shortcodetương ứng như sau: 

• Giỏ hàng: [woocommerce_cart] 

• Tài khoản của tôi: [woocommerce_my_account] 

• Thanh toán: [woocommerce_checkout] 

Khi một hoặc tất cả trang có sẵn trong Woocommerce bị mất do chúng ta lỡ xóa đi hoặc vì 

lý do nào đó, chúng ta có thể tạo lại bằng cách vào Woocommerce -> Tình trạng hệ thống -> 

Công cụ -> và ấn vào nút Cài đặt trang. 

 

Như vậy là bây giờ chúng ta có thể hiểu sơ qua về một số trang.Và dĩ nhiên, chúng ta có 

thể đưa nó lên menu của website nếu muốn tại mục Giao diện -> Trình đơn. 

I. Thêm sản phẩm đơn giản 

I.1) Nhập thông tin sản phẩm 

Để thêm một sản phẩm, chúng ta vào Sản phẩm -> Thêm sản phẩm. 

http://thachpham.com/wordpress/wordpress-development/cach-tao-shortcode-tu-a-toi-z.html
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Menu thêm sản phẩm 

Tại đây nó sẽ giống như trang thêm bài viết, nhưng nó sẽ có nhiều chức năng riêng để thêm 

một sản phẩm. 

Phần tiêu đề và nội dung chúng ta sẽ nhập nó như tiêu đề sản phẩm và nội dung mô tả chi tiết 

của sản phẩm. 

Nhập tiêu đề và mô tả chi tiết của sản phẩm 

Ngay bên dưới nó là phần Dữ liệu sản phẩm, ở đây chúng ta hãy chọn là Sản phẩm đơn 

giản. Ở bên dưới khung đó là các phần chúng ta nhập thông tin sản phẩm như giá cả, mã sản 

phẩm, quản lý kho hàng,…. 
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Khung nhập dữ liệu sản phẩm 

• Chung: Phần này sẽ nhập thông tin về mã sản phẩm và giá sản phẩm. 

o Mã sản phẩm: Nhập mã sản phẩm để chúng ta tiện quản lý trong kho hàng. 

o Giá bán chuẩn: Giá chuẩn của sản phẩm. 

o Giá khuyến mãi: Giá sản phẩm sau khi được giảm, chúng ta có thể lên lịch để 

giá khuyến mãi có hiệu lực trong thời gian nhất định. 

• Kiểm kê kho hàng: Phần này sẽ thiết lập số lượng sản phẩm trong kho và tình trạng 

hàng hóa trong kho. 

o Quản lý kho hàng?: Chúng ta muốn thiết lập số lượng hàng trong kho thì đánh 

dấu vào. 

o Tình trạng kho hàng: Tình trạng của sản phẩm này là còn hàng hay hết hàng. 

Nếu chúng ta bật tính năng kiểm kê kho hàng thì khi khách mua hết số lượng đã 

thiết lập thì nó đưa về tình trạng hết hàng. 

o Bán riêng: Đánh dấu nếu chúng ta muốn khách chỉ được mua với số lượng 1 cái 

của mặt hàng này trong một đơn hàng. 

• Giao nhận: Thiết lập trọng lượng, kích thước của sản phẩm và loại hình giao hàng. 

o Trọng lượng: Nhập số trọng lượng của sản phẩm, đơn vị sẽ được thiết lập ở 

Woocommerce -> Cài đặt. 

o Kích thước: Nhập chiều dài, chiều rộng và chiều cao của sản phẩm, đơn vị sẽ 

được thiết lập ở Woocommerce -> Cài đặt. 

o Loại hình giao nhận hàng: Chọn loại hình giao nhận hàng. 

• Các sản phẩm được kết nối: Kết nối các sản phẩm lại với nhau để người mua có thể 

dễ dàng tìm ra các sản đó và gợi ý khách hàng mua kèm thêm. 
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o Bán thêm: Gợi ý khách hàng mua sản phẩm thay cho sản phẩm hiện tại mà họ 

đang xem. Ví dụ sau này chúng ta có một sản phẩm tốt hơn sản phẩm này thì có 

thể thêm nó vào phần này. 

o Bán chéo: Gợi ý khách hàng mua thêm trong lúc xem giỏ hàng, ví dụ chúng ta 

bán iPhone 6S thì nên thêm các sản phẩm như sạc, vỏ điện thoại vào phần bán 

chéo để họ mua kèm thêm. 

o Nhóm: Chọn nhóm sản phẩm cần đưa vào. Nhóm sản phẩm nghĩa là họ mua 

theo một nhóm chứ không mua riêng lẻ, cái này mình sẽ nói riêng ở phần khác. 

• Các thuộc tính: Thiết lập thuộc tính sản phẩm như màu sắc, kích thước,…nhưng mình 

sẽ nói kỹ hơn ở phần khác. 

• Nâng cao: Một số thiết lập thêm cho sản phẩm. 

o Ghi chú thanh toán: Ghi chú mà chúng ta muốn gửi đến khách hàng sau khi 

mua hàng. 

o Menu đơn hàng: Số thứ tự ưu tiên của sản phẩm trong giỏ hàng, số càng nhỏ 

thì càng ưu tiên. 

o Cho phép đánh giá: Đánh dấu nếu muốn cho khách hàng đánh giá sản phẩm. 

Nhưng hiện tại, chúng ta chỉ nên thiết lập sản phẩm ở phần Chung mà thôi, các 

phần khác chúng ta nên để nguyên và sẽ làm chi tiết ở các bài sau. 

 

Tiếp tục kéo xuống dưới, chúng ta sẽ thấy phần mô tả ngắn của sản phẩm. Phần này để 

chúng ta nhập mô tả ngắn, ví dụ như một lời giới thiệu ngắn về sản phẩm vì nó sẽ hiển thị ngay 

bên dưới giá sản phẩm trong trang chi tiết của sản phẩm. 
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I.2) Thiết lập danh mục sản phẩm 

Tiếp tục chúng ta nhìn qua bên tay phải của trang thêm sản phẩm sẽ thấy phần thiết lập 

danh mục sản phẩm, nhìn chung nó giống hệt chức năng Category (Chuyên mục) trong bài viết 

thôi. Nếu chưa có chúng ta có thể thêm mới một danh mục và chọn nó. 

 
I.3) Thiết lập từ khóa sản phẩm 

Từ khóa sản phẩm là các từ khóa mà chúng ta cho là có liên quan đến sản phẩm. Ví dụ 

mình đặt danh mục là Áo thun thì nên chọn từ khóa các kiểu như áo lacoste, áo cá sấu, áo pike 

chẳng hạn. 

http://img.thach.io/wp-content/uploads/2015/10/23141110/woocommerce-them-san-pham-05.jpg
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thiết lập từ khóa sản phẩm 

I.4) Ảnh sản phẩm 

Mỗi sản phẩm nên có một ảnh sản phẩm, hay còn gọi là ảnh đại diện cho sản phẩm. 

I.5) Thư viện hình ảnh của sản phẩm 

Ngay bên dưới phần ảnh sản phẩm là phần thư viện hình ảnh sản phẩm, nói chính xác hơn thì 

đây là danh sách nhiều hình ảnh mà chúng ta muốn nó hiển thị theo dưới dạng slide (trình diễn 

ảnh) trong trang sản phẩm. Chúng ta nên chọn một số tấm ảnh khác của sản phẩm này ở đây, 

khi chọn ảnh chúng ta hãy ấn Ctrl để chọn nhiều ảnh. 
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II. Thử nghiệm chức năng giỏ hàng và thanh toán 

Bây giờ hãy thử thêm sản phẩm của chúng ta vào giỏ đi. Lúc này chúng ta sẽ thấy nó để một 

thông báo là đã thêm sản phẩm vào giỏ hàng. 

 

Và khi chúng ta click vào giỏ hàng thì nó sẽ hiển thị thế này. 
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Và ấn nút Thanh toán để xem được trang thanh toán. Lưu ý là trang thanh toán có thể hơi xấu 

do đang thực hành trên một theme mặc định và nó chưa hiển thị tốt với Woocommerce. 
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III. Tắt khung bình luận ở trang giỏ hàng và thanh toán 

Như bây giờ chúng ta thấy là khi vào trang bình luận và giỏ hàng, chúng ta sẽ thấy một 

khung bình luận khá vô duyên bên dưới. Đơn giản vì nó là Trang trong WordPress nên sẽ có 

khung đó. Để tắt thì chúng ta chỉ cần sửa lại trang giỏ hàng và thanh toán, sau đó nhìn lên trên 

phía bên phải chọn Tùy chọn hiển thị. Và đánh dấu vào Thảo luận. 

 

 Sau đó bỏ chọn hai tùy chọn dưới khung Thảo luận. 

 

Chúng ta đã tìm hiểu qua cách đăng một sản phẩm đơn giản. Tiếp tục bây giờ chúng ta nên tìm 

hiểu qua chi tiết các thiết lập của Woocommerce có tại trang Woocommerce -> Cài đặt để 

chúng ta biết qua nó có gì trong đó mà vào mò khi cần. 

Tại trang Woocommerce -> Cài đặt, chúng ta sẽ có các hạng mục như hình dưới. 

http://thachpham.com/wordpress/wp-plugin/them-san-pham-don-gian.html
http://thachpham.com/series/hoc-woocommerce
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Tổng quan trang thiết lập Woocommerce 
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Cài đặt chung 

 

Phần thiết lập chung này sẽ có các thiết lập chung của cửa hàng như địa chỉ của cửa hàng, tùy 

chọn định dạng tiền tệ,… 

Tùy chọn chung 

• Khu vực mặc định: Thiết lập này sẽ chọn khu vực mặc định của cửa hàng để nó dựa 

theo mà tính thuế, phí giao nhận,.. 

• Khu vực bán hàng: Danh sách các quốc gia được phép đặt hàng trên website của 

chúng ta, chúng ta có thể chọn các quốc gia cần bán hoặc chọn toàn bộ quốc gia. 

• Địa chỉ khách hàng mặc định: Thiết lập chức năng tự định vị địa chỉ của khách hàng 

hoặc tắt khi khách hàng đặt hàng. Nhìn chung thì nên chọn là Không có địa chỉ để họ tự 

nhập vào hay hơn. 

• Thông báo của cửa hàng: Bật chức năng hiển thị một dòng thông báo trên toàn bộ 

website. 

• Tùy chọn tiền tệ 

• Tiền tệ: Loại tiền tệ cần sử dụng trên website 

• Vị trí tiền tệ: Vị trí hiển thị số tiền với ký hiệu tiền tệ 



Bộ môn Hệ thống thông tin 

 

Hướng dẫn thực hành – Quản trị Website với Word Press Page 108 | @TaiLieuITIUH 
 

• Dấu cách phần ngàn: Dấu ngăn cách đơn vị hàng nghìn trên giá sản phẩm. 

• Dấu thập phân: Dấu ngăn cách đơn vị thập phân trên giá sản phẩm. 

• Số đơn vị thập phân: Số lượng số 0 đứng đằng sau đơn vị thập phân, tiền Việt Nam 

không sử dụng số này nên nhập là 0. 

Cài đặt sản phẩm 

Ở trang cài đặt này, nó có thêm 4 hạng mục nhỏ bên trong nữa mà chúng ta cần nên để ý. 

 

Chung 

Đo lường 

• Đơn vị trọng lượng: Chọn loại đơn vị tính trọng lượng của sản phẩm, nó sẽ có tác động 

tới việc tính phí giao nhận. 

• Đơn vị kích thước: Chọn loại đơn vị tính kích thước của sản phẩm, nó sẽ có tác động 

tới việc tính phí giao nhận. 

Đánh giá 

Phần xếp hạng sản phẩm là nơi chúng ta chọn các thiết lập liên quan tới việc gửi đánh giá vào 

sản phẩm, nó đã có ghi rõ ở phần này rồi nên chúng ta cứ đọc rồi chọn cái nào mình cần nhé. 

Hiển thị 

Ở đây sẽ có các thiết lập liên quan đến việc hiển thị sản phẩm ra ngoài website. 
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Cửa hàng & Trang sản phẩm 

• Trang cửa hàng: Thiết lập trang mà chúng ta muốn nó làm trang cửa hàng (hiển thị các 

sản phẩm mới nhất có phân trang). 

• Hiển thị trang cửa hàng: Tùy chọn kiểu hiển thị sản phẩm ở trang cửa hàng. 

• Kiểu hiển thị danh mục mặc định: Tùy chọn kiểu hiển thị sản phẩm trong các trang 

danh mục sản phẩm. 

• Kiểu sắp xếp sản phẩm mặc định: Thiết lập kiểu sắp xếp sản phẩm ở các trang danh 

mục sản phẩm. 

Hình sản phẩm 

Đây là các thiết lập kích thước hình ảnh của sản phẩm hiển thị ra bên ngoài website. 

*Bắt buộc cắt ảnh (hard-crop): Tùy chọn này nghĩa là nó sẽ tự động cắt ảnh của chúng ta 

upload lên để nó có kích thước chính xác với cài đặt của chúng ta. Nếu không chọn thì nó sẽ 

thu lại về kích thước được cài đặt mà không cắt ảnh nhưng sẽ không đúng 100%. 

• Ảnh catalog: Thiết lập kích thước ảnh đại diện của sản phẩm mà nó hiển thị ở trang 

danh sách các sản phẩm. Xem ảnh mô tả. 

• Ảnh sản phẩm đơn lẻ: Thiết lập kích thước của ảnh sản phẩm mà nó hiển thị đầy đủ 

trong trang chi tiết sản phẩm. Xem ảnh mô tả. 

• Hình thu nhỏ sản phẩm: Thiết lập kích thước của ảnh thu nhỏ sản phẩm ở phần thư 

viện ảnh sản phẩm.Xem ảnh mô tả. 

• Thư viện ảnh sản phẩm: Đánh dấu bật lightbox nếu chúng ta muốn sử dụng hiệu ứng 

lightbox trình diễn ảnh khi click vào ảnh ở thư viện ảnh sản phẩm. 

Lưu ý: Sau khi thay đổi kích thước hình ảnh, chúng ta phải tiến hành tái tạo (rebuild) lại hình 

ảnh trong thư viện để nó tiến hành cắt lại. Chúng ta có thể tái tạo lại hình ảnh thông qua 

plugin AJAX Rebuild Thumbnail. 

Kiểm kê kho hàng 

• Quản lý kho hàng: Đánh dấu nếu chúng ta cần bật chức năng quản lý sản phẩm trong 

kho hàng. 

• Thời gian giữ hàng: Thiết lập thời gian giữ đơn hàng khi khách hàng chưa thanh toán, 

nếu quá thời gian thì đơn hàng sẽ bị hủy. Đơn vị ở đây tính bằng phút, mặc định là 60 

phút. 

• Thông báo: Tùy chọn gửi thông báo khi sản phẩm sắp hết hàng và khi hết hàng. 

• Notification Recipients: Địa chỉ email của người quản trị để nhận thông báo, chúng ta 

có thể nhập nhiều email ngăn cách bằng dấu phẩy. 

• Ngưỡng sắp hết hạn: Ngưỡng số lượng sản phẩm trong kho sẽ nhận thông báo sắp hết 

hàng. 

http://img.thach.io/wp-content/uploads/2015/10/05091810/thiet-lap-woocommerce-05.jpg
http://img.thach.io/wp-content/uploads/2015/10/05091810/thiet-lap-woocommerce-04.jpg
http://img.thach.io/wp-content/uploads/2015/10/05091810/thiet-lap-woocommerce-06.jpg
http://thachpham.com/wordpress/wp-plugin/xay-dung-lai-hinh-anh-su-dung-ajax-thumbnail-rebuild.html
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• Ngưỡng hết hàng: Ngưỡng số lượng sản phẩm trong kho sẽ nhận thông báo hết hàng. 

• Mức độ hiển thị hết hàng: Đánh dấu nếu chúng ta cần ẩn các sản phẩm đã hết hàng. 

• Định dạng hiển thị hàng hóa: Kiểu hiển thị số lượng sản phẩm trong khi trên sản 

phẩm. 

Sản phẩm có thể tải về 

• Phương thức tải tập tin: Chọn phương thức tải tập tin của các sản phẩm có thể tải về. 

Trong đó, phương thức X-Accel-Redirect/X-Sendfile chúng ta có thể hiểu là chuyển 

hướng nội bộ để giấu đường dẫn gốc của tập tin. 

• Hạn chế truy cập: Đánh dấu nếu muốn đăng nhập mới tải được tập tin. Lưu ý là khi bật 

tùy chọn này, chúng ta phải bật chức năng đăng ký tại Cài đặt -> Tổng quan trên 

WordPress. 
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HƯỚNG DẪN SAO LƯU, PHỤC HỒI DỮ LIỆU 

Giới thiệu BackWPUp 

BackWPUp là một plugin miễn phí hỗ trợ tự động sao lưu dữ liệu website WordPress thông 

dụng nhất hiện nay, với số lượng download mỗi ngày gần 2000 lượt. 

Sở dĩ plugin này được nhiều người sử dụng như vậy là bởi vì nó vừa dễ sử dụng, tốn ít 

tài nguyên và hỗ trợ tự động upload dữ liệu được backup qua host khác thông qua FTP, hoặc 

các dịch vụ lưu trữ đám mây như Dropbox và Amazon S3. 

Mặc dù BackWPUp không hỗ trợ tính năng khôi phục dữ liệu nhanh chóng nhưng khi 

đã có file backup rồi, chúng ta có thể thực hiện khôi phục dữ liệu thủ công. 

Các tính năng của BackWPUp gồm 

• Backup database 

• Backup mã nguồn của website trên host 

• Tùy chỉnh thư mục không cần backup 

• Tối ưu database khi backup 

• Kiểm tra và sửa lỗi database khi backup 

• Lưu danh sách plugin lại thành file text .txt 

• Nén dữ liệu lại thành .zip, .tar, .gz,… 

• Tùy chỉnh thư mục lưu dữ liệu backup trên host 

• Gửi file backup qua FTP của host khác, Dropbox, Amazon S3, RackSpace, Google 

Drive, Amazon Glacier, SugarSync,… 

• Gửi email thông báo kèm file log. 

• Cấu hình host để dùng BackWPUp 

• Để sử dụng plugin BackWPUp tốt nhất, host của chúng ta phải cài các phần mềm với 

cấu hình như sau: 

• WordPress 3.4 trở lên. 

• PHP 5.3 trở lên. 

• Có hỗ trợ mysqli, cURL, nén gz, zip. 

Ngoài ra, hãy chắc chắn là thư mục /wp-content/uploads/ trên 

host của chúng ta đang được CHMOD là 755. 

Cách sử dụng BackWPUp 

Sau khi cài plugin và kích hoạt BackWPUp xong, chúng ta 

sẽ thấy trên Dashboard có một menu tên BackWPUp ở cột tay 

trái. 

Trong đó: 

• Dashboard: Khu vực chứa các thông tin chung về tiến 

trình backup trên website. 
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• Jobs: Danh sách các tiến trình backup tự động, mỗi job là một tiến trình backup. 

• Add new Job: Thêm một tiến trình backup mới. 

• Logs: Xem nội dung các file log của mỗi lần backup. 

• Backups: Xem danh sách các file backup trên website. 

• Settings: Thiết lập plugin. 

• About: Giới thiệu tổng quan plugin BackWPUp. 

Để chắc chắn là cấu hình host của chúng ta phù hợp với BackWPUp, chúng ta nên vào 

phần BackWPUp -> Settings -> Information để xem thông tin cấu hình host, ở đó chúng ta sẽ 

xem được các phiên bản của từng phần mềm đang chạy trên host. 

 

Tạo một job mới 

Để tạo một job backup mới, hãy vào BackWPUp -> Add new Job. 

Tại đây, chúng ta khai báo các thông tin về tiến trình tự động backup. Phần Job Destination là 

thiết lập nơi cần lưu dữ liệu backup, nếu chúng ta mới sử dụng thì nên chọn Backup to Folder 

để nó lưu dữ liệu backup lên host. 

Dưới đây là cách thiết lập thông dụng nhất: 
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Kế tiếp là chuyển qua tab Schedule để thiết lập lịch backup tự động, chúng ta hãy chọn With 

WordPress cron và chọn là daily nếu muốn job này chạy mỗi ngày. 

Tới bước này thì chúng ta đã có thể backup được rồi, nên hãy ấn Save Changes lại. Nếu muốn 

chúng ta có thể tự tìm hiểu thêm các chức năng còn lại. 

Bây giờ để chạy thử Job, hãy vào BackWPUp -> Jobs -> ấn nút Run now của cái job 

vừa tạo để nó bắt đầu backup xem có lỗi gì xảy ra không. 
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Và nó sẽ bắt đầu backup kèm tiến trình để chúng ta xem. 

 

Chúng ta có thể ấn vào nút Display working log để xem nó làm việc tới đâu và có lỗi gì 

màu đỏ không. Nếu nó chạy hết 100%, chúng ta có thể vào BackWPUp -> Backups để xem 

file chứa dữ liệu backup của chúng ta, chúng ta có thể tải về máy. 

 

Trong file dữ liệu backup này sẽ bao gồm mã nguồn website của chúng ta và file .sql 

chứa database, chúng ta có thể khôi phục bằng cách thủ công khi cần thiết. 
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Hướng dẫn phục hồi website WordPress 

• Một file nén chứa mã nguồn của website. 

• Một file .sql chứa database của website. 

Ngoài ra, khi phục hồi bạn nên tạo một database mới hoàn toàn và thư mục cần khôi phục 

tập tin trên host cũng phải được trống hoàn toàn. 

Cách phục hồi dữ liệu WordPress thủ công 

Bước 1. Phục hồi mã nguồn 

Để phục hồi mã nguồn thì dễ hơn, đó bạn là hãy upload file nén chứa mã nguồn của 

website lên host thông qua tính năng File Manager.Để phục hồi được dữ liệu của website 

WordPress hoàn chỉnh nhất, bạn cần có: 

 

Sau khi upload xong, hãy chọn file nén và ấn Extract. 

 

Giải nén xong bạn đã có các thư mục và tập tin mã nguồn của website trên host rồi. 
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Bây giờ bạn hãy mở tập tin wp-config.php ra và sửa các đoạn sau đây thành thông tin 

database mới của bạn rồi lưu lại. 

01 

02 

03 

04 

05 

06 

07 

08 

09 

10 

11 

/** The name of the database for WordPress */ 

define('DB_NAME', 'TÊN-DATABASE'); 

  

/** MySQL database username */ 

define('DB_USER', 'USERNAME-DATABASE'); 

  

/** MySQL database password */ 

define('DB_PASSWORD', 'MẬT-KHẨU-DATABASE'); 

  

/** MySQL hostname */ 

define('DB_HOST', 'localhost'); 
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Bước 2. Khôi phục database 

Để khôi phục database, bạn hãy truy cập vào phpMyAdmin trên host. 

 
Truy cập công cụ PhpMyAdmin 

Và chọn database cần khôi phục. 

Và chọn Import trên thanh công cụ. 

 

Rồi upload tập tin .sql chứa database của website bạn lên và ấn Go, các thiết lập khác giữ 

nguyên. 
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Nếu nó báo thành công thế này là được rồi. 

Bây giờ hãy kiểm tra tiền tố của database xem có trùng với thiết lập trong file wp-

config.php trên host không nhé. Tiền tố database là các ký tự trước dấu “_” của các bảng dữ 

liệu (table). 

Và đây là đoạn thiết lập tiền tố database trong file wp-config.php, hai cái này phải trùng 

nhau thì website mới chạy được. 

01 $table_prefix  = 'wp_'; 

Bước 3. Cập nhật permalink 

Sau khi khôi phục lại dữ liệu xong, bạn cần phải flush permalink trong website bằng 

cách vào Settings -> Permalinks và ấn nút Save Changes là được. 

Xong.  bây giờ hãy kiểm tra xem website  đã hoạt động tốt chưa nhé! 

<Tham khảo> 

 


